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ABSTRACT

Functionally graded advanced composite materials contain reinforcement
particles whose volume fraction varies continuously thereby bearing a non-uniform
microstructure with continuously changing properties. Aluminum-based functionally
graded materials (FGMs) reinforced with AIB, particles were manufactured by
centrifugal casting to obtain these graded properties, which can not be achievable in
monolithic or homogeneous materials. Volume fraction of pores and reinforcements
particles, superficial Rockwell hardness (HR15,), Vickers microhardness (HVsp), and
stereological parameters from the microstructure were measured on Al -2 wt.% Mg -
1, 2, 3 and 4 wt.% B centrifugally cast and gravity cast composites. These materials
showed AIB, particles segregation toward the external zone of the cast piece,
resulting in higher hardness and microhardness in this region. Wear behavior of the
composites was studied by pin-on-disk wear test. This test was conducted on five
zones (0, 5, 10, 15 and 20mm) sectioned along the length of the cylinder of the
centrifugally cast aluminum matrix composites (AMC’s) and on stationary (gravity)
cast specimens. The results of this study showed the smallest wear volume on the
external zone (20mm) of the FGMs. Morphological characterization of the wear
tracks by scanning electron microscopy (SEM) helped corroborate the wear volume

results.
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RESUMEN

Materiales compuestos avanzados de gradiente funcional contienen particulas
de refuerzo cuya fraccion de volumen varia permitiendo la formacion de micro-
estructuras no-uniformes con propiedades que cambian continuamente. Materiales
de gradiente funcional a base de aluminio (FGMs) reforzados con particulas de AlB;
fueron fabricados mediante fundicion centrifuga a fin de obtener propiedades las
cuales no se pueden lograr en materiales homogéneos o monoliticos. Fraccion de
volumen de poros y particulas de refuerzo, dureza superficial Rockwell (HR15y,
microdureza Vickers (HVsp), tamafio de grano de la fase de matriz de aluminio y
tamafio de las particulas de diboruro fueron medidos sobre compuestos de Al-2
wt.%Mg - 1, 2, 3 y 4 wt.% B, fundidos centrifugamente y por gravedad. Estos
materiales mostraron segregacion de particulas de AIB; hacia la regidbn mas externa
de la pieza fundida, resultando en una mayor dureza y microdureza en ésta region.
Se estudiéo el comportamiento al desgaste de éstos compuestos por medio del
ensayo de desgate pin-on-disk. Este ensayo se realiz6 en cinco zonas (0, 5, 10, 15
y 20 mm) seccionadas a lo largo de la longitud de los cilindros de los compuestos
de matriz de aluminio fundidos centrifugamente y sobre muestras fundidas
estacionariamente (por gravedad). Los resultados del estudio mostraron el menor
volumen de desgaste sobre la zona externa (20 mm) de los materiales de gradiente
funcional. La caracterizacion morfologica de las pistas de desgaste haciendo uso
del microscopio electrénico de rastreo (MER) ayudd a corroborar los resultados de

volumen de desgaste.
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1. INTRODUCTION

Metal matrix composites (MMCs) reinforced with ceramic or metallic particles are
widely used due to their high specific modulus, strength and wear resistance.
Furthermore, MMCs have been considered as an alternative to monolithic metallic
materials or conventional alloys in a number of specialized applications [1]. In
particular, aluminum matrix composites (AMCs) have been reported to possess
higher wear resistance and lower friction coefficient with increasing volume fraction

of reinforcement particles, compared to aluminum alloys without reinforcement [2].

Functionally graded composite materials (FGMs) contain volume fraction
distribution of reinforcement particles which varies continuously from the inner to the
outer sections of the cast piece giving a controlled non-uniform microstructure with
continuously changing properties [3]. Surface modification and coating methods
provide this effect and are widely used to improve tribological properties of metallic
materials, but the added surface treatment increases the manufacturing costs. On
the other hand, centrifugal casting is appears to be an effective method to process
FGMs. This type of pressure casting method involves pouring molten metal into a
mold when the mold assembly is under the action of a centrifugal (inertial) force

produced by a rotational or spinning motion.
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This research reports the manufacturing, composition gradient determination,
preliminary characterization of microstructural and mechanical properties, and wear
response of FGM-AMCs reinforced with AIB, particles obtained by centrifugal
casting. The original semisolid material consisted of a uniform dispersion of AlB;
particles entrapped in molten aluminum. The resulting redistribution of volume
fraction of reinforcement particles was controlled by the inertial forces toward the
outer region of the cast component during centrifugal casting. This redistribution was
assisted by the higher density of the AIB, particles compared to the molten
aluminum. The forced segregation of hard borides towards the outer regions of the
casting provided a unique approach to improve surface hardness [4] and wear

resistance of the composite.

1.1 Motivation

Surface modification and coating methods are widely used to improve
tribological properties of metallic materials for a wide range of applications. The
corresponding techniques are very diverse; thermo-chemical diffusion, laser
treatment and plasma, and physical and chemical vapor deposition. However, in all
these methods the surface treatment is applied after the part has been fabricated,

adding significantly to the overall costs.

FGMs are useful in applications where high wear resistance and high bulk

toughness are a necessity. Therefore, special processing is required to produce
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these materials in order to exhibit characteristics that are not achievable by

monolithic or homogeneous materials [5].

FGMs - AMCs reinforced with diborides have not been studied extensively
despite being strong and lightweight materials. AMCs combine the low density of the
matrix with the high hardness of the reinforcers. For this reason extensive analysis
and characterization of these AMCs are relevant if they are proposed as alternative

materials for aerospace applications.

Cast FGMs - AMCs reinforced with diborides represent an effective,
alternative in aerospace application where light weight, low-cost and wear resistance
are a necessity. Furthermore, centrifugal casting is one of the most effective
methods for processing this kind of AMCs because, under centrifugal forces, the
heavier ceramic particles entrapped in the liquid metal are displaced toward the
outer surface of the casting [6]. The principal advantage of centrifugal casting is to
produce very good mold filling combined with good microstructural control, which
usually results in improved mechanical properties. However, a complete
understanding of the particle segregation and distribution phenomena has not been
yet fully described. Nevertheless, it is still possible to formulate a composition

gradient due to the difference in material density [7].
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1.2 Literature Review

The tribological behavior of reinforced AMC’s has been investigated by
numerous researchers and there are many published works related to this subject.
Most of them have demonstrated the enhanced tribological performance of the
composites compared to unreinforced alloys [1]. However most of the literature on
reinforced AMCs has been focused on homogeneous materials (uniform distribution

of reinforcers).

Some previous work in the area of FGM aluminum matrix composites include
the study of Kang and Rohatgi (1996) who performed a transient thermal analysis of
solidification in a centrifugal casting for composite materials containing particle
segregation [8]. In this research one-dimensional heat transfer analysis during
centrifugal casting of aluminum alloy and copper-based MMCs containing Al,O3
SiC,, and graphite particles were studied. They proposed a numerical model of
particle segregation during centrifugal casting of liquid metal containing suspended
particles. In addition, they considered that liquid metal temperature is influenced by
the speed of rotation, the variation of reinforcement and the constitution of the base
alloy. Additionally, the initial mold temperature and its speed of rotation were found
to be significantly affected by the solidification time due to particle segregation

(measured as volume fraction).

Watanabe and Fukui (2000) carried out an analysis of microstructures and

mechanical properties of FGMs fabricated by a centrifugal casting method [7]. The



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

particle distribution gradient of the dispersed compounds (Al/SIiC; Al/AlsTi; Al/AlzNi)
was established. The author reported the variation of matrix hardness with the
composition gradient. Mechanical properties such as Young’s modulus, internal
friction, fatigue crack growth in an in-situ Al/AlzNi FGM were evaluated. Analysis of
thermal residual stress was done on Al/SIC FGM and, wear behavior of Al/Al;Ti FGM
was determined. This study mainly showed that SiC particles move toward the
casting outer parts under the action of centrifugal force (due to the denser particles).
The same trend was found in AlsTi. Al/AlsNi FGM which is an application of the in-
situ technique using the crystallization phenomena exposed a uniform volume
fraction distribution of particles and decrease in particle diameter in the outer region
of the casting. Analysis of matrix revealed a direct relation between hardness and
volume fraction of particles. Internal friction and Young's modulus increased with
increasing volume fraction of particles. Effect of graded composition on the
fractography is not clear. However, since the graded composition affects the crack
path, this may increase the toughness of material. The analysis on Al/SIC FGM
showed that thermal residual stresses are greater for higher composition gradient.
Finally, the wear volume of Al/Al;Ti specimens were much lower than those of pure

Al

Gomes et al. (2003) performed a tribological characterization of
homogeneous gravity cast aluminum-based matrix composites and aluminum
composites with functionally graded properties, obtained by centrifugal casting and

reinforced with SiC particles [9]. These composite materials were tested against
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nodular cast iron in a pin-on-disc tribometer in order to evaluate their friction and
wear properties. The worn surfaces as well as the wear debris were characterized
by SEM/EDS and by atomic force microscope (AFM). The friction coefficient
revealed a slight decrease when FGMs are involved in the contact instead of the
homogeneous composite. Relatively low values of the wear coefficient were
obtained for functionally graded aluminum matrix composites. Characterization of
the worn surface indicated that the effect of reinforcing particles played a decisive

role in the friction and wear properties of aluminum matrix composites.

In 2003 Velihinho et al. presented the effect of particle size on reinforcement
distribution [10]. In this work, different SiC particle sizes (reinforcing elements) were
added to AMCs which were molten and centrifugally cast in order to produce the
FGM composites. They found that larger sized particle reinforcement gives rise to
higher hardness levels throughout the material. At the same time this originates
steeper gradients than in those materials prepared with smaller reinforcements. In
particular, if the particles are large enough, total or partial particle depletion occurs in

some regions away from the FGM surface.

In 2004 Nai et al. analyzed the effects of different reinforcement particles
such as SiC, Al,O3 and TiC on three aluminum based FGMs [5]. Further analysis of
porosity level, microhardness, thermomechanical and wear on these AMCs were
carried out. The results for Al/SIC and Al/Al,O3 revealed a general increase in the

weight percentage of reinforcement along the direction of deposition, which results in
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an increase in porosity and microhardness. On the other hand, the opposite trend
was observed for Al/TIC, Thermomechanical analysis of the FGMs showed that the
average coefficient of thermal expansion of the high reinforcement end was reduced,
when compared to the aluminum-rich end. Sliding wear test results also revealed
that the high reinforcement end was more wear resistant than the aluminum-rich

end, except for the case of Al/Al,O3

Although there are other publications on FGMs, most of them explain
processing techniques and characterization methods very similar to the ones
described previously. A common finding in this literature review has been the use of
SiC as reinforcement particle inside the aluminum matrix. Other ceramic and

intermetallic reinforcement particles have been used but to a lesser degree.

In a previous thesis completed at UPRM [11] the advantageous mechanical
properties of the AI/AIB, composites were demonstrated. The present work will

establish the specific properties of this composite as FGM.

A binary Al-B alloy rich in Al consists of an almost pure aluminum matrix
containing small ceramic particles (AlBy). In the equilibrium Al-B system, boron is
practically insoluble. Currently, Al-rich alloys of this system are used as master
alloys for grain refining of aluminum [12]. The aluminum diborides contained in those
alloys are in reality catalytic substrates for the early crystallization of the aluminum

phase [13]. There is an excellent wettability between the borides, acting as
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reinforcing particles, and the aluminum melt without any deleterious chemical
reaction. Other ceramic particles such as SiC react with the molten alloy to form
reaction products that weaken the particle-matrix interface, which results in harmful

effects on the composite.

1.3 Objectives

The main purpose of this research is to develop a technique to produce
FGMs made of Al-B-Mg composites. Additionally, these FGMs will be characterized
in order to identify their composition gradient and microstructural and tribological

properties.

The specific objectives of this work are:

e Develop a process of centrifugal casting which allows producing functionally

graded Al/AIB, composites.

e Obtain FGM-AMCs reinforced with AIB; particles from Al-B-Mg composites.

e Characterize and analyze volume fraction distribution of reinforcement

particles (composition gradient) and pores of FGMs-AMCs.
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e Determine microstructural and mechanical properties on FGMs-Al-B-Mg
composites such as, matrix grain size, reinforcement particle size and

superficial Rockwell hardness and Vickers microhardness.

e Conduct a preliminary tribological characterization of FGMs-AMCs through
wear volume and wear coefficient measurements obtained from pin on disk

wear tests.

1.4 Organization of this Thesis

In Chapter 2 the necessary theoretical background is developed. Chapter 3
treats the performance of the methodology to process the Al-B FGM composites
from centrifugal casting. Characterization of the Al-B FGMs composites is done by
determination of volume fraction distribution of reinforcement and pores, superficial
Rockwell hardness and Vickers microhardness testing. Then, wear volume and wear
coefficient of Al-B FGM composites are measured from wear tests in a pin-on-disk
apparatus. The fourth chapter presents the processing and characterization of FGM-
Al-B-Mg composites. Investment casting and centrifugal casting are used as
processing methods. Volume fraction distribution of reinforcement and pores,
superficial Rockwell hardness and Vickers microhardness testing, matrix grain size
and reinforcement particle size are to be characterized in this Al-B-Mg FGM.

Afterwards, the results of wear volume, wear coefficient and morphology of worn
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surface were analyzed after the pin-on-disk wear tests. Conclusions are presented in

Chapter 5 while Chapter 6 provides some recommendations for future research.

10
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2. THEORETICAL BACKGROUND

2.1 Functionally Graded Materials (FGMs)

Functionally graded materials (FGMs) are new advanced multifunctional
composites where the volume fractions of the reinforcements phase(s) (or
dispersoids) vary smoothly. This is achieved by using reinforcements with different
properties, sizes, and shapes, as well as by interchanging the functions of the
reinforcement and matrix phases in a continuous manner. The result is a
microstructure bearing continuous changes in thermal and mechanical properties at
the macroscopic or continuum scale [14]. In other words FGM is usually a
combination of two materials or phases that show a gradual transition of properties
from one side of sample to the other. This gradual transition allows the creation of
superior and multiple properties without any mechanically weak interface. Moreover,
the gradual change of properties can be tailored to different applications and service

environments.

In general, there are two approaches to fabricate FGMs, as shown in Fig 2.1.
The first one is to eliminate the interface of coated — or joined-type composites (from
c to b), eliminating discontinuities in the properties at the interface. The second one
is to induce non-uniform distributions of reinforcement particles in an originally
homogeneous composite (from a to b), creating multiple functions inside the

material. Several FGM fabrication methods have been proposed. However, thus far,
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it has been difficult to produce relatively large FGM components by most fabrication
methods. In addition, those methods require relatively new techniques and

expensive fabrication equipment [7].

Ceramic or
Intermetallic

Particle
omogeneous

Metallic matrix omposite a)

FGM b)
Coated or
Joined- Type C)
Composite

Figure 2.1 Approaches to FGMs, a) homogeneous composite, b) FGM, c) coated-or joined-type
composite.

This new concept of materials engineering hinges on materials science and
mechanics due to the integration of the material and structural considerations into
the final design of structural components. Because of the many variables that control
the design of functionally graded microstructures, full utilization of the FGMs
potential requires the development of appropriate modeling strategies for their

response to combined thermomechanical loads.

12



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

FGMs are ideal candidates for applications involving severe thermal
gradients, varying from thermal structures in advanced aircraft and aerospace
engines to computer circuit boards. These materials were introduced to take
advantage of ideal behavior of its constituents, e.g. heat and corrosion resistance of

ceramics together with mechanical strength and toughness of metals [15].

Many processing methods have been proposed to fabricate FGMs, such as
chemical vapor deposition, the plasma spray technique and various powder
metallurgy techniques. The centrifugal method was introduced recently and has
attracted a lot of attention due to its unique merits [16]. In particular, Al based FGMs
fabricated by the centrifugal method showed interesting properties that are not
obtained in conventional monolithic materials, such as gradual changes in hardness,

wear resistance, Young’'s modulus, etc [17].

2.2 Cast Metal Processing

2.2.1 Centrifugal Casting

One application of centrifugal casting is in FGM fabrication. In this method, a
centrifugal force applied to a homogeneous semiliquid composite, (containing
ceramics or intermetallic compound particles) drives the formation of the desired
gradient (from a to b in Fig 2.1). The resulting composition gradient is produced by

the difference in density between the molten metal and the particles under the same
13
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centrifugal force. Compared to other techniques, the centrifugal method is potentially
applicable to mass production of both small and large FGM components at a low
cost. Mechanical properties of FGMs fabricated by this method have been

investigated using relatively large samples [7].

The fabrication of ceramic or intermetallic compound-dispersed FGMs made
by the centrifugal method can be classified into two categories according to the
melting point of the ceramic or intermetallic compound. If the melting point is
significantly higher than the processing temperature, the intermetallic compound
remains solid in a liquid matrix. The FGMs obtained by this method are named as a
solid particle technique. On the other hand, if the melting point of the intermetallic
compound is lower than the processing temperature, centrifugal force can be applied
during the solidification both to the intermetallic compound and to the matrix. This
solidification is similar to the production of in-situ composites using the crystallization

phenomena, and this method is, therefore, named as an in-situ technique [7].

Centrifugal casting is one of the most effective methods for processing metal
matrix composites (MMCs). Nevertheless, understanding of the particle distribution
mechanisms has not yet been fully achieved. Several parameters influence the
characteristics of FGMs: atmosphere in the neighborhood of the melt, melt pouring
temperature, mold temperature, thermal gradient across the molds, solidification
rate, centrifugal force and pouring rate. These parameters affect several phenomena

when the liquid metal containing solid particles solidifies in the mold such as:
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interaction and/or chemical reactions between the solidification front and the moving
particles; rate of variation of the melt viscosity during solidification; interaction
between particles and liquid; or the initial position of the particles in the mould,
before starting their movement in the liquid. The balance between these phenomena
determines the effect in terms of particle distribution, overall microstructure and FGM

properties [10].

Centrifugal casting method has been used to avoid interdendritic segregation
of reinforcing particles, such as Al,O3 and SiC,. In addition, some models have
been developed for this procedure in order to predict mainly, composition gradient,
temperature distribution and local solidification time. As an illustration, transient
thermal analysis of solidification in AMCs centrifugally cast has been proposed to
describe particle segregation [8]. Although the model developed has not been fully
validated it provides an adequate one-dimensional heat-transfer analysis during
centrifugal casting of AMCs containing Al,O3, SiC, and graphite particles. The model
of particle segregation is calculated by varying the volume fraction during centrifugal
casting, using the finite difference method. According to this research article, when
the reinforcer density p, is higher than that of the liquid matrix pm, the particle volume
fraction Vs at a distance r; of the casting rotation axis after a time increment At can be

linearized as indicated in equation 3.1.

ViR = Vi) - T e VD) o (3.)
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The actual nondimensional position of each individual particle r; is obtained by ratio

" . . . Xi
between the actual position x; and the maximum radius of the casting X: r; = YI If

each particle is assumed to be spherical with radius R, then, its position can be also

estimated as a function of time and the rotation speed w:

2. 2
(1) = 1(0) -exp [2"’ (2o o) B t} (32

Where, r(0) is the position of the particle at t=0 and 7 is the kinematic viscosity of the
composite constituted by a liquid metallic matrix and solid particles. The thickness of
the particle-rich region near the inner periphery, therefore, can be modeled by using
equation 3.2. This allows for adjusting the mold rotation speed ® to produce a
certain volume fraction of reinforcing particles Vi. The solidification time of the
casting decreases with an increase of w. The apparent viscosity 7 of the composite
is estimated as a function of the liquid matrix viscosity 7. and the particle volume

fraction V; as indicated by equation 3.3 [18].

n=n [1 + % Vi+ 7.6 szj (3.3)

Until now, there has been no attempt to apply this model to functionally graded
composites where, intentionally and carefully, reinforcing particles are pushed by

centrifugal forces to the outer layers of a casting.

16



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

2.2.2 Investment Casting

Investment casting is also known as the lost wax process and is one of the
oldest manufacturing processes. The name “Investment” was originated because the
Egyptians approximately 5,000 years ago used this technique to make gold jewelry.
Investment Casting is a simple technique that allows production of castings with
complex shapes and high accuracy without the subsequent need to machining them.
Also this technique can be used to make parts that cannot be produced by normal
manufacturing techniques such as turbine blades that have complex shapes, or

airplane parts that have to resist high temperatures.

The basic procedure of investment casting is illustrated in Fig. 2.2. The mold
is made by making a pattern using wax or some other material that can be melted
away. This wax pattern is immersed in refractory slurry, which coats the wax pattern
and forms a skin. After drying (immersing in the slurry and drying), the process is
repeated until a robust thickness is achieved. After this, the entire pattern is placed
in an oven and the wax is melted away. This generates a mold that can be filled with
the molten metal. Because the mold is formed around a one-piece pattern, very
complex parts can be made. The wax pattern is made by duplicating using a stereo
lithography or similar model-which has been fabricated using a computer solid model

master.
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The materials used for the slurry are a mixture of plaster, a binder and
powdered silica, a refractory, for low temperature melts. For higher temperature

melts, sillimanite, an alumina-silicate is used as a refractory, and silica is used as a

a b c )
I R

d E
Wax replicas of The shell is built by ﬁ'

the desired cast The patterns are immersing the Once the ceramic
piece are created attached to a assembly in a liquid is dry, the wax is
by Injection central wax stick, ceramic  slurry and melted out,
molding. ~ These called a sprue, to then into a bed of creating a negative
replicas are form a casting extremely fine sand. impression of the
called patterns cluster or Several layers may assembly  within
assembly. be applied in this the shell
manner

In the usual process, After minor finishing

the shell is filled with The parts are ,

molten metal by x\ggencggédm;ﬂ cut away from opetra|1t|ons, i the
gravity pouring. As solidified, ~ the e central dontical  to the
the metal cools, the ceramic shell is Sprue using a original wax
parts and gates, broken off by hl_gh speed a?terns—-are read
sprue and pouring vibration or water friction saw ?or chioment o thz:/
cup become one blasting customper

solid casting

Figure 2.2 The Basics of the Investment Casting Process [19] a) Wax Injection b) Assembly c) Shell
Building d) Dewax e) Conventional Casting f) Knockout g) Cut Off h) Finished Castings
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binder. Depending on the fine quality of the finish desired additional coatings of
sillimanite and ethyl silicate may be applied. The mold thus produced can be used
directly for light castings, or be reinforced by placing it in a larger container and
reinforcing it with more slurry or coarse sand. Just before the pour, the mold is pre-
heated to about 1000 °C (1832 °F) to remove any residues of wax and harden the
binder. The pour in the pre-heated mold also ensures that the mold will fill
completely. Pouring can be done using gravity, pressure or vacuum conditions.
Attention must be paid to mold permeability when using pressure, to allow trapped

air to escape [20].

2.3 Metal Matrix Composites (MMCs)

Metal matrix composites are materials that have a metal or metal alloy as the
matrix phase. The dispersed phase may be particulates, fibers, or whiskers that

normally are stiffer, stronger, and/or harder than the matrix [21].

2.3.1 General Consideration

Three main types of MMCs can be classified according to these
reinforcement; continuous-fiber, discontinuous-fiber, and particulate reinforced.
Continuous-fiber reinforced MMCs, possess higher stiffness and strength because of
continuous filaments. One of the first continuous-fiber to be developed MMC, was
the aluminum alloy matrix-boron fiber reinforced system. Other continuous-fiber

reinforcements that have been used in MMCs are silicon carbide, graphite, alumina,
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and tungsten fibers. Many types of discontinuous and particulate reinforced MMCs
have been produced. These materials have the engineering advantage of higher
strength, greater stiffness, and better dimensional stability than the unreinforced
metal alloys. Particulate reinforced MMCs commonly employ aluminum alloy MMCs
made by using irregular-shaped particles of alumina and silicon carbide within 3 -
200 pm in diameter. The particulates, which sometimes were previously coated, can
be mixed with the molten aluminum alloy and cast. Discontinuous-fiber reinforced
MMCs are produced mainly by powder metallurgy and melt infiltration process.
Whisker dispersion produces higher strength and stiffness than particulate ones.
Nevertheless, the powder metallurgy processing and melt infiltration methods are

more expensive [22].

2.3.2 Characteristics of MMCs

Metals are extremely versatile engineering materials. A metallic material can
exhibit a wide range of easily controllable properties through appropriate selection of
alloy composition and thermomechanical processing method. The broad use of
metallic alloys in engineering shows not only their strength and toughness but also
the relative simplicity and low cost of fabrication of engineering components by a

wide range of manufacturing processes.

The necessity of achieving better properties that those obtained in monolithic
metals has allowed the development of different kinds of MMCs. Therefore, new

materials resulting from the addition of reinforcements to a metal may provide
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enhanced specific stiffness coupled with improved fatigue and wear resistance, or
perhaps increased specific strength coupled with desired thermal characteristics in
the resulting MMC. However, the cost of achieving appropriate improvements

remains a challenge in many potential MMC applications.

One of the main problems is focused on ensuring the optimum degree of
chemical contact (or wetting) between the fibers or reinforcements and the matrix. In
many systems, wetting is inhibited by oxide films or surface chemistry features of the
reinforcing phase. Procedures to improve the interfacial characteristics often results
in an undesirable degree of fibers/matrix interaction and damage. At elevated
temperatures, inherent thermodynamic incompatibility was observed in the early

MMCs. They are associated with wetting and stability problems [23].

Some differences among MMCs, polymer matrix composites (PMCs), and
ceramic matrix composites (CMCs) are as follows. MMCs evidence higher ductility
and toughness than CMCs, although they have lower ductility and toughness than
their respective unreinforced metal matrix alloys. The role of the reinforcement in
MMCs is to increase strength as is the case with PMCs. Reinforcement in CMCs is
generally to provide improved damage tolerance; MMCs are temperature resistant,

generally higher than polymers and PMCs but less than ceramics and CMCs.

The choice of a matrix alloy for an MMC is dictated by several considerations,

the type of reinforcement is one of particular interest. In continuously reinforced
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AMCs the use of fibers as reinforcements may result in transfer of most of the load
to the reinforcing filaments and hence composite strength will be governed primarily
by the fiber strength. For discontinuously reinforced MMCs, the matrix may govern
composite strength in which case, the choice of matrix will be influenced by the

required composite strength and matrix alloys [24].

2.4 Aluminum Matrix Composites (AMCs)

Particular interest has been paid on the use of aluminum and its alloys as
matrix material in metal matrix composite owing to their low density. Al/SiC,
Al/Graphite, Al/Boron, Al/Al,O3 are all well known aluminum matrix composites
systems. In the manufacturing of these cast metal matrix composites a foremost
topic is the appropriate incorporation of the reinforcements into the molten alloy,
feature briefly mentioned earlier. It is a major issue that the melt should not only
engulf but also “wet” the ceramic particles or reinforcement in order to prevent
particle agglomeration, settling, and segregation, and to avoid discontinuities in the
particle-matrix interface. Non-reactive, highly stable oxides, such as Al,O3 particles,
are not wetted by molten aluminum, and these particles are pushed by the
solidification front and segregate in the last metal to freeze. In many cases the
reinforcers (e. g. SiC, graphite, etc.) react with the molten alloy to form reaction
products that weaken the particle-matrix interface. As a consequence, deleterious
reaction products can be formed in the composite (e.g. Al,C3 particles in AMC

containing graphite or some carbide as reinforcements). In other words, chemical
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reactivity between liquid Al matrix and ceramic particles must be considered in

developing new Al matrix composites.

The lack of wetting and the potential reaction between Al and reinforcements
can be overcome if the reinforcing particles are already present in the microstructure
under thermodynamic equilibrium for the aluminum solidification temperature range.
One system that results in an almost pure aluminum matrix containing small ceramic
particles is Al-B. Currently, Al-rich alloys of this system are used as master alloys for
grain refining of aluminum alloys [12]. The AIB;, present in these alloys is basically a
catalytic substrate for the early crystallization of the aluminum phase [13]. This is to
say that there is an excellent wettability between the borides, acting as reinforcing

particles, and the aluminum melt without any deleterious chemical reaction.

Several melt-processing techniques have been used in aluminum matrix
composites (AMC) with different degrees of success to favor the incorporation of
reinforcing particles. The high cost of production of AMCs can postpone additional
applications of these profitable materials. For this reason, the design of new AMCs
with a stable microstructure (in terms of matrix/reinforcer reactivity) is a requirement

to keep the cost of production at low levels.

Mechanical properties of AMCs are significantly affected by the magnitude
and the nature of residual stresses inherent in metal matrix composites. These

stresses frequently are related with differences in thermal expansion coefficients
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between matrix and reinforcements particles. Sometimes phase transformations can
result in additional micro-residual stresses as well. Besides, small amounts of plastic
deformation can significantly alter the state of residual stresses produced during
fabrication [25]. As a final point, reinforcing aluminum alloys with ceramic particles
produces high strength aluminum matrix composites. This property enables the
applicability of AMC in the aerospace and defense industries, as well as in

automotive disk brake rotors, pistons, upper control arms, etc.

2.4.1 Al - Mg Binary Alloy

The AI-Mg system, its thermodynamic and physical properties, phase
equilibria, and diffusion data are important for the production of light,
multicomponents alloys. For this reason thermodynamic studies of liquid Al-Mg
alloys, and complementary studies of solid, and phase equilibria of Al-Mg alloys
have been performed in order to calculate the phase diagram of the Al-Mg system

[26].

Aluminum — Magnesium alloys are broadly classified as wrought (1 to 5 wt%
Mg) and cast (5 to 10 wt% Mg) alloys. Above 7% Mg at room-temperature
precipitation takes place and causes an increment in strengthening by work
hardening in both types of Al-Mg alloys. On the other hand the mechanical
properties are not affected by the aging treatment. This point of view is controversial,
since the precipitation hardening treatment generally enhances the mechanical

strength of aluminum alloys. Equilibrium precipitate [AlsMg2(B8), complex face-
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centered cubic (fcc), a = 28.2A, 37.3 % Mg] has been observed to be preceded by
nonequilibrium precipitates (e.g., Guinier—Preston (GP) zones, B” [AlsMg with L1,
structure] and B’ [hexagonal phase with a = 11.3 A and ¢ = 17 A]). Recent
calorimetric studies have indicated that the precipitation temperatures of 8’ and g are
100° and 250°C, respectively, and the dissolution temperature of B’ + B is 250°C to
420°C. The presence of trace amounts of heterogeneities facilitate formation of g,
and, the lack of heterogeneities/dislocations allows the formation of 8. This phase
has been reported to be susceptible to twinning, which can be avoided only by slow
cooling from the melting temperature. The decline of mechanical properties during
long-term (natural aging) is usually attributed to the formation of GP zones. This
phenomenon is widely studied and compared with the formation of B’/ 8 precipitates

at relatively high temperatures [27].

Mg forms a complicated system with Al, as is shown in Fig 2.3. Mg decreases
the density of Al; density decreases linearly by approximately 0.5% for every 1%wt%

Mg in solid solution [25].

Magnesium has a very high solid solubility in solid aluminum (up to 14.9 wt%
at 450° C); this solubility decreases to approximately 1.7 wt% at room temperature,
but the rate of decomposition of the supersaturated solid solution is very low [25]. In
addition, Mg provides to molten aluminum alloy at 880 °C better fluidity at 15wt% for
each 1 wt% of Mg with respect to an unmodified alloy [28]. Nucleation and growth of

the B phases on the grain boundaries in certain Al-Mg (>3wt%Mg) alloys at room
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temperatures reduce ductility and resistance to stress-corrosion cracking. Both yield
strength and ultimate tensile strength increase with increasing Mg content while
elongation drops sharply with even small Mg additions. Similar behavior with
increasing Mg content is observed in tensile properties of commercial alloys. On an
atomic basis, Mg is more efficient in strengthening in concentrations less than 1 at%

than in more concentrated alloys [25].
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Figure 2.3 Al-Mg Binary Alloy Phase Diagram [25]

26



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

It is know that the addition of Mg influences the stacking-fault energy and
thus, the strength, the recovery and the recrystallization characteristics of Al.
Furthermore, the presences of Mg solute atoms may lead to the appearance of
plastic instabilities resulting in the well known serrated yielding or Portevin-Le

Chatelier (PLC) effect [29].

2.4.2 Aluminum Diboride (AlIB,)

Equilibrium phases in the Al-B system have been the object of extensive
studies [30]. Experiments studying thermal behavior in all composition ranges in the
binary AI-B system revealed at least seven invariant temperatures [30]. Early
investigations of the constitution of the system Al-B claim the existence of a eutectic
reaction L—Al + AIB, at 560°C at 30 to 35at.%B. AIB, forms peritectally from Al(L)
and AlB;; at 1100 °C [30]. All things considered, it can be concluded that the stable
solid phases in the Al-B stable system are BB, aAlBiz, BAIB12, AlBio, AIB, and Al.
Despite the continuing controversy on the existence of BAIB;, and AlBjp, all the
experimental evidence leads to the conclusion that these phases are impurity
(carbon) stabilized and that AIB, and AlB;, are the only true binary aluminum boride
compounds [31]. It is also shown that a carbon impurity has a tendency to shift the
peritectic temperature to higher temperatures. Thus experimental viewpoint indicates
that the Al-B system seems susceptible to impurities and the use of the crucible. It is
apparent that the use of graphite crucible alters the occurrence of phases when B

concentration is high enough.
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2.4.3 Other Transitional Metal Diborides

The AIB; type structures (hps) types are among the most commonly found in
intermetallic binary and ternary compounds. The boron atoms form honeycomb
layers, while Al atoms are located at the centers of hexagonal prisms that are
formed by the B sheets. Transition metal diborides, belonging to this family, are
being studied in some detail because of their potential application in electronic
devices to overcome current problems of electromigration, corrosion, and diffusion
into the semiconductor substrate. The largest interest has undoubtedly been the
discovery of superconducting properties in MgB, which also crystallizes in the simple

AlB; as is shownin Fig. 2.4 [32].

In January 2001 the superconducting properties of MgB, were discovered with
a Tc = 39K, which was followed by a flurry of studies seeking to increase T, by
uncovering the basic physics. MgB; is analogous to other intermetallics compounds
with high T; coming from the exceptionally high vibrational energies in the graphite-
like boron planes (honeycombed layers). MgB, has AIB,-like hP3 tetragonal crystal
structure, as does TiB,, and the c/a ratios are similar for 1.082 and 1.142,
respectively for AIB, and MgB; [33]. In a preliminary investigation, powder mixtures
containing MgB; and high purity Al were compacted and sintered. The compact was
later treated at 750°C or arc-melted to investigate the stability of MgB; in the
presence of molten Al. According to x-ray microanalysis the thin boride plates
contain Al and Mg with a likely formula Al;.xMgyxB,. This solubility is not entirely

surprising due to the aforementioned affinity between AIB, and MgB,. Additionally,
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due to the low atomic numbers of Mg and Al, both compounds have mostly metallic
bonds, which differentiate them from other transition metal diborides, e.g. ZrB,, NbB,
and HfB,, which have a strong covalent contribution to the atomic bonding, which

results in higher melting points [34].

Figure 2.4 Crystal Structure of AlB, [32]

However, what makes all these diborides particularly interesting for the
present research is their hardness [35] and small sizes, which translates into
effective obstacles for dislocation glide on the {111} Al planes, i.e. an aluminum
matrix composite reinforced with diborides. Furthermore, the transition metal

diborides also possess a higher density than aluminum, which is a major advantage.
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Table 2.1 displays literature data on density and melting points of pertinent

diborides.

Diboride Bulk Density at Room Melting Point
Temperature (g/cm?®) (°C)
AlB, 3.09 1,655
CrB, 5.20 2,200
HfB 11.20 ~3,380
NbB; 6.60 3,036
TiB, 4.38 3,225
ZrB, 6.17 3,245

Table 2. 1 Reported bulk densities and melting points of some transition metal diborides [30,
36-38].

2.5 Stereological Analysis

Effective microstructural characterization has motivated the development of
practical image analysis to measure particle count, phase volume fraction and size
for various materials. Along the years the science of stereology was consolidated,
based upon a mathematical framework that allowed systematic, manual and
automatic measurements using various overlay grids for accurate and efficient
measures of two- dimensional images which allowed three-dimensional information
about the microstructure [39]. Stereology is the science of the geometrical

relationships between a structure that exists in three dimensions and the images of
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that structure that are fundamentally two-dimensional (2D) [40]. Although these
images may be obtained by various means, they usually fall into two basic
categories: images of sections through the structure and projection images viewed
through structure. The most intensive use of stereology has been in combination
with microscope images, which includes light microscopes (conventional and

confocal), electron microscopes and other types.

Image analysis is based on processes which allow obtaining various
measurements from images. There are many measurements that can be made,
such as size, shape, position and brightness of all features present on a given image
as well as the total area covered by each phase. Most of these values are not very
directly related to the three-dimensional (3D) sample that is presented and
represented in the image. Stereological relationships provide a group of geometrical
tools that can relate some of the measurements on the images to important
parameters of the actual 3D structure. Only those parameters that can be calculated
from the stereological relationships truly characterize the 3D structure. Among
objects that can occupy three dimensional space we can mention essentially:
objects that have a volume, such as particles, grains, cells, pores or voids, and
fibers; two dimensional surfaces, which include the surface of the 3D objects, the
interfaces and boundaries between them, and objects such as membranes; one
dimensional feature, which include curves in space formed by the intersection of
surfaces; zero dimensional features, which are basically points in space. By

comparison, image analyzers are quite good at counting but not as competent at
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recognizing features of interest. Fortunately, there has been tremendous progress in

the development of powerful, user friendly computerized image analyzers.

The introduction and the now widespread application of digital image
processing system has allowed measuring the geometry of such two-dimensional
structures more rapidly, more precisely and more comprehensively than ever before.
Digital images analysis from a range of microscopic techniques can aid in the
investigation of microstructural components across meter scale down to point
defects in the atomic domain. The stereological interpretation of the geometrical data
extracted from planar images is essential for the establishment of correlations
between processing parameters, and the material properties. This topic has been

greatly advanced in recent years by developments in stochastic geometry [41].

2.6 Wear

2.6.1 Introduction

Wear is an important topic from an economical point of view because it
represents one of a very limited number of ways in which material objects lose their
usefulness. The response of a material to friction and wear is determined by a
number of factors related to fundamental properties of the materials in contact.
Unfortunately the inherent interdependence among those factors and properties

encumber a straightforward analysis of this phenomenon. Historically, the study of
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the wear process was initiated very late, so the explanation of the laws of wear is
relatively recent. There was the attitude on the part of many engineers and scientists
that wear was a phenomenon so complicated and erratic that a systematic

investigation was considered to be a waste of time [42].

Perhaps the biggest challenge in solving wear problems is related with
preventing the types of wear to which components will be subject. Material can be
removed from a solid surface in only three ways: by melting, by chemical dissolution,
or by the physical separation of atoms from the surface. The last method can be
accomplished either by the one-time application of a high strain or by cyclic straining
at lower magnitudes. Mechanical and chemical processes may operate separately

or together, such as abrasion in a corrosive medium [43].

2.6.2 Surface Damage and Wear

Surface damage is defined as topographical or microstructural changes, or
both, on a surface layer. Surface damage to a tribosystem is most often generated in
many consecutive small steps by a number of different micromechanisms that are
active in the tribosurface. The observed damage is thus the cumulative effect on a
macroscale of these micromechanisms [43]. Ideal classification of surface damage
based on the resulting surface is illustrated in Fig 2.5. In principle, a tribosurface
may exhibit damage of a single type, but generally the pattern is a combination of
two or more types. Examination and interpretation may be quite complex. All the

types of damage shown in Fig 2.5 will in practice influence a surface layer. It can be

33



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

noted that using the present definition, topographical or structural changes of the

surface layer damage is not necessarily harmful.

The surface damage without exchange of material can be classified as:
structural changes such as aging, tempering, phase transformations,
recrystallization, etc; and plastic deformation which is the damage characterized by
residual deformation of the surface layer, either locally or extensively. The latter is
often revealed as a change in shape; surface cracking is the damage caused by
excessive local contact strains or cyclic variations of thermally or mechanically
induced strains. The latter case can cause dense patterns of parallel cracks whereas

thermal cycling lattice generates a network of cracks.

Figure 2.5 Classification of surface damage a) Structural changes b) Plastic deformation c)
Surface cracking d) Wear e) Gain of material f) Corrosion [43].
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Surface damage involving loss of material (wear) is based on the loss of
material of the surface, which leaves behind wear scars of various shapes and sizes.
Fundamental elements in the process of material removal can be shear fracture,
extrusion, chip formation, tearing, brittlle fracture, fatigue fracture, chemical
dissolution, and diffusion. Finally surface damage involving gain of material explores,
first, the phenomenon of picking up loose particles, transfer of material from the
countersurface, etc, and the corrosion event consisting of material degradation by

chemical reactions with ambient elements or elements from the countersurface.

The fact that the damage observed on a tribologically loaded surface normally
is a combination of two or more of the types illustrated in Fig 2.5 indicates that
several mechanisms have been operating simultaneously. The overlapping
mechanisms generally do not operate independently, but interact to mutually
increase the effects of one another. An example of such synergistic interactions is
the simultaneous corrosion and wear involved in high temperature erosion.
Occasionally, however, the combined effects can lead to a net reduction of the
individual effects. One example of such a counteractive interaction is the inhibition of
severe adhesive wear of metals in sliding contacts by the formation of an oxide layer

[43].

Wear may be defined as the surface damage or removal of material from one
or both of two solid surfaces in a sliding, rolling, or impact motion to one another as

a result of mechanical action. It is characteristic that the amount of material removed
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in the wear process is quite small [42]. Wear is generally based on loss of material,
but it should be emphasized that damage due to material displacement on a given
body, with no net change in weight or volume, also constitutes wear. In addition,

wear as friction, is not a material property, it is a system response [44].

Finally we can say that wear is undesirable in almost all machine applications
such as bearings, gears, and cams. Components may need replacement after a
relatively small amount of material has been removed or if the surface is unduly

roughened.

2.6.3 Types of Wear

Adhesive Wear. Adhesive wear occurs when two smooth bodies are in sliding
contact, whether lubricated or not. Adhesion (or bonding) occurs at the asperity
contacts at the interface and these contacts are sheared by sliding, which may result
in detachment of a fragment from one surface and attachment to the other surface.
Later these fragments may come off the surface on which they are formed and be
transferred back to the original surface, or else form loose wear particles. Adhesive
wear arises from the strong adhesives forces set up whenever atoms come into

intimate contact [44].

In an early theory of sliding wear, it was suggested that shearing can occur at
the original interface or in the weakest region in one of the two bodies. In most

cases, interfacial adhesion strength is expected to be small as compared to the
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breaking strength of surrounding local regions; thus, the break during shearing
occurs at the interface in most of the contacts and no wear occurs in that sliding
cycle. In a small fraction of contacts, break may occur in one of the two bodies and a
small fragment may become attached to the other surface. In another mechanism,
plastic shearing of successive layers of an asperity contact results in detachment of

a wear fragment.

Abrasive Wear. Abrasive wear occurs when asperities of a rough, hard
surface or hard patrticles slide on a softer surface and damage the interface by
plastic deformation or fracture. In the case of ductile materials with high fracture
toughness, hard asperities or hard particles result in the plastic flow of the softer
material. Most metallic and ceramic surfaces during sliding show clear evidence of
plastic flow, even some for brittle ceramic materials. Contacting asperities of metals
deform plastically even at the lightest loads. In the case of brittle materials with low
fracture toughness, wear occurs by brittle fracture. In these cases, the worn zone
consists of significant cracking. There has sometimes been confusion between fine

abrasive wear a form of relatively benign adhesive wear [44].

Corrosive Wear. Corrosive wear occurs when sliding takes place in a
corrosive environments. In air, the most dominant corrosive medium is oxygen.
Therefore chemical wear in air is generally called oxidative wear. In the absence of
sliding, the products of corrosion will form a film on the surfaces. This film tends to

delay or even detain the corrosion. However, the sliding action wears the film away,
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so the corrosive attack continues. Thus chemical wear requires both chemical

reaction (corrosion) and abrasion [44].

Surface Fatigue Wear. Surface fatigue wear is observed during repeated
sliding or rolling over a track. The repeated loading and unloading cycles to which
the materials are exposed may induce the formation of surface or subsurface cracks,
which eventually will result in the break up of the surface with the formation of large

fragments leaving large pits in the surface [44].

Studies of the wear process indicate that the adhesive wear is the most
common and least avoidable form of wear. As far as is known, this form of wear is
universal in all mechanical systems in which two solids slide in contact with each

other. It cannot be eliminated but only reduced [42].

2.6.3 Tribological Parameters

Many investigators use standard test geometries for wear and friction test,
such as pin-on-disk or four-ball tests. The amount and structures of damage to these
components is of great interest in such tests. Parameters such as the volume of
material removed by wear and the surface area of the wear scar (track) are

commonly the items to be determined in these tests [43].

There are different types of scratch test devices which can be organized into

three main categories (see Fig 2.6): Type 1 corresponds to low-speed bench top
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scratching machines, normally equipped with a stylus to produce a scratch on a flat
with a single pass (Fig 2.6a), with a reciprocating movement (Fig 2.6b), or with a
multiple pass (Fig 2.6c); Type 2 are low-speed scratching devices that operate in
situ in the beam path of a scanning electron microscope (SEM), intended for detailed
mechanism studies; Type 3 refers to high speed scratching machines, which include
penduli (Fig 2.6d) and grinding wheels (Fig 2.6e); essentially used for single pass

grooving.

e ——

Figure 2.6 Scratch test devices a) Single pass b) Reciprocating ¢) Multiple pass d) Modified
charpy pendulum e) Modified grinding machine[43].

The analysis of wear data of such tribosystems or corresponding laboratory
test configurations and test specimens requires special attention because numerous

characteristics, parameters, and factors must be taken into consideration. In a wear
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test the resistance against surface damage (wear) of a material pair (dry system) or
a material/lubricant/material combination in a given environment is determined under
the action of a certain type of motion, such as sliding or rolling. The resulting
tribometric characteristics—in particular the wear data must be understood as
characteristics of tribological systems associated with the structural, operational, and
interaction parameters. The structural parameters are characterized by the
component such as materials, lubricant and environment involved in the wear
process and their physical, chemical, and technological properties. The operational
parameters are mainly kinematic and temperature conditions and their functional
duration. Interaction parameters characterize in particular the action of the operating
parameters on the structural components of the tribological system and define its

contact and lubrication modes.

The principal parameters that can be measured on the wear test are: Length,
that is, one-dimensional changes in the geometry of the interacting triboelements
perpendicular to their common contact area; Area, that is, two-dimensional changes
of cross sections of interacting triboelements perpendicular to their common contact
area; Volume, that is, three-dimensional changes of geometric regions of interacting
triboelements adjacent to their common contact area. Wear volume is associated via
density or specific gravity with wear masses of wear weights. In addition to these
guantities, a wear-time ratio may be defined as wear velocity. Other common wear
parameters are the wear rate, which is the wear volume per unit of sliding distance,

and the wear coefficient, K, defined according to equation 3.4 [43].
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(3.4)

Where:
W = Wear volume (mm?)
Fn = Applied load (N)

s = sliding distance (m)

It should be emphasized that generally wear quantities must be determined for both

components involved in a wear process.

The most common way of studying wear consists of pre and post examination
of the sliding materials, with any differences in the materials attributed to wear. The
detection of wear generally uses techniques of weighing, mechanical gaging, or
optical examination of the surface features. The weighing method is usually the
simplest way of detecting wear, since it at once gives the total amount of wear in the
form of a single number. For this method it is necessary to remove from the sliding
mechanism the component to be examined, to clean it carefully and then to carry out
the weighing on a chemical balance. The limit of resolution of the weighing method

is generally around 10 g [42].

2.6.4 Wear of Metal Matrix Composites

Metal matrix composites are attracting considerable interest because of their

superior mechanical and tribological properties. As mentioned previously, these
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materials have a metal matrix in which nonmetallic fibers, particles, or whiskers are
dispersed. For use in tribological applications, metal-matrix composites must be able
to support a load without excessive distortion, deformation, or fracture during
performance and to maintain controlled friction and wear over long periods without
breakdown under working conditions. The composites containing hard particles
generally exhibit different friction and wear behavior than composites containing soft

particles in alloys with the same matrix.

Particulate-reinforced composites are less expensive than fiber-reinforced
composites, due to the lower cost of the particles providing their tribological
applications. Furthermore, the mechanical and physical properties of particle
composites are generally isotropic. In metal-matrix composites, mechanical
properties depend on the amount, size, shape and distribution of the dispersed
phase apart from the mechanical properties of the matrix material and on the nature

of the interface.

The fracture toughness of particulate composites is low, and it decreases with
volume fraction of a dispersed phase [43]. A weak interface leads to crack at low
strain, and a low fracture toughness value indicates their easy propagation. In the
context of the wear, these two properties are critical to the generation and
propagation of cracks, resulting in wear debris. Pores in composite may act as
preexisting crack nuclei in the system, and later become unstable at appropriate

stress level. Porosity thus increases composite wear rate.
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During tribological interaction between two surfaces, temperature rises
significantly at and near the surface, and the mechanical properties of the composite
at elevated temperature may be significant. The dispersed hard particles are helpful
in retaining the high temperature strength of the matrix. Also, the loss of the strength
due to dynamic recrystallization is supported by the presence of particles. Metal-
matrix composites can thus have superior mechanical properties at elevated
temperatures, even though their room temperature properties are not appropriate for

certain systems.

Wear behavior of metal matrix composites depends on the nature of particle
reinforcements in close relation to the matrix containing them. The particles can be
softer or harder compared with the matrix. Ceramic particles generally used as
reinforcements include carbon, silicon carbide, and alumina, which have low
adhesion to a metallic counterface. The asperity of the counterface can easily break
through softer particles such as carbon; it cannot do so through harder particles

such as alumina or silicon carbide.

The abrasion resistance of a material generally is determined by two different
types of test: low-stress tests, such as rubber wheel abrasion test and high-stress
tests, such as pin-on-disk and pin-on-drum types of test. Tests employing high
stress levels break the abrasive particles. The size and shape of the abrasive
particles, as well as their relative hardness with respect to the composite being

tested, are important parameters in determining the degree of wear. Under high-
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stress conditions, the wear rate decreases almost linearly with the volume fraction of

reinforcement particles in a composite.

Specific abrasive wear rates as a function of volume fraction for several hard
particles dispersed in aluminum matrices showed that wear rates decrease with an
increasing volume fraction of particles similarly to those observed in adhesive wear
[43]. For a given volume fraction of particles, composites that contain harder

particles exhibit a lower wear rate [43].

Under abrasive wear, the coefficient of friction in composites containing hard
particles is also a function of the volume fraction of reinforcement particles. As the
volume fraction of hard particles increases, the coefficient of friction decreases for
both aluminum-based and copper-based composites. The increase in the volume
fraction of hard particles in the matrix alloy reduces the area fraction of matrix, and

thus there is enhanced ceramic-ceramic contact [43].
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3. DEVELOPMENT OF PROCESSING AND CHARACTERIZATION

METHODOLOGY FOR FGM - Al-B COMPOSITES

Through this chapter the reader will find the methodology used to manufacture
aluminum-based FGMs reinforced with AIB, particles and their characterization
procedure. To produce this FGM-AMC, centrifugal casting was considered the most
appropriate technique for a commercial Al-5wt.% B alloy and an experimental Al- 4
wt.% B and 2 wt.% Mg alloy. The composite microstructure was characterized both
gualitatively and quantitatively. Quantitative image analysis was used to evaluate the
distribution of the reinforcement particles for Al-B and Al-Mg-B alloys in three
conditions: as-received condition, gravity cast condition and internal and external
zones of the centrifugally cast samples. These results were correlated to the values
of superficial Rockwell hardness and Vickers microhardness measured on those
composites. Unlubricated pin-on-disk configuration wear tests were conducted on
the external and internal zones of the centrifugally cast AMC’s and on stationary
(gravity) cast specimens (disks). The Figure 3.1 illustrates a summary of

methodology defined to processing and characterizing these material composites.

45



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

INVESTMENT CASTING| g Wax Models q Gypsum N Melting Wax Mold
”| (1.6cm@, 2.0 cm length) "1 Hydrostone Molds > (autoclave) 1

\ 4

CENTRIEUGAL » | °/Initial rotation velocities (0,and 200 rpm)
CASTING P« Melting Temperature 750°C
\ 4
SAMPLE Cross sections (External,
CUTTING > midlde, and internal zone)

\ 4

METALLOGRAPHIC CHARACTERIZATION
PREPARATION (FGM and AMC)

v , v

v

Microstructure Volume fraction of Superficial Rockwell Wear Test
(Optical microscopy) reinforcement particles hardness and Vickers Pin-on-disk
microhardness (Wear volume and
Wear Coefficient)

Figure 3.1 Diagram showing the experimental procedure sequence

3.1 Investment casting

The investment-casting process consists of three distinct steps: making an
initial pattern (an exact replica of the article to be produced); building a refractory
“shell” (mold) around the pattern and removing the original pattern, usually by heat
and pouring molten alloy of the desired composition in to the shell. After the metal
has solidified, other operations involve shell removal, finishing, and heat treating, but

the general investment casting process is accomplished in these three steps.

In the present work, investment casting was limited to the first two steps:
model-making and mold preparation. The metal pouring (third step) will be detailed
in the centrifugal casting section. To fabricate the model, FILE-A™- blue wax blocks

were used. This wax is one of the most flexible carving waxes and excellent to
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reproduce rounded parts and has a melting temperature of 105 °C. The model,
contrary to a typical technique of injecting molten wax, was machined from a wax
block, since, the final casting piece to be produced was a cylinder with a 16 mm in
diameter and 20 mm in length (Figure 3.2 a). The smooth surface obtained in the
model guaranteed the high-quality final surface of the metallic sample. In addition
machining the wax block avoided undesirable injection characteristics of the wax
such as shrinkage during solidification, dimensional stability, strength, thermal
expansion near room temperature, etc. Maintaining the proper wax model properties

helped ensure that the final metal shape was an exact replica of the wax pattern.

The finished wax model was encased in a ceramic mold material known as
the “investment”. The mold was made by the flask molding method. In this molding
method, the wax model was set into the flask and ceramic slurry was poured around
the pattern. The ceramic used was hydrostone gypsum and the resulting mold is in
the shape of a solid cylinder or block (see Figure 3.2 b). Once the mold is ready and
completely dry the pattern must be removed. This operation is referred to as
“dewaxing”, which is usually accomplished by inserting the mold into a steam
autoclave or a high-temperature furnace (flash firing). The steam autoclave was the
more appropriate technique for our particular goal, as is shown in Figure 3.2 c. The
dewaxing setting parameters were 120°C and 30 minutes. Shells were normally fired
immediately after dewaxing to burn off any residual wax and other organics. After
residuals have been burned out, the mold is ready for metal pouring (Figure 3.2.d).

As a particular experience, it was found that the removal of a pattern can be done
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manually without melting the wax if the model surface was so much smooth and the
model geometry was very simple. It helped to save time but implied additional

changes in the model to hold it when the model was removed.

Figure 3.2 Investment Casting Process a) Model b) Investment c) Dewaxing d) Mold

3.2 Centrifugal Casting Process

Centrifugal casting is a technique used to obtain materials with higher density
in the outer regions of a casting due to applied centrifugal forces. A Romanoff 79-
049-T centrifugal casting machine (see Figure 3.3 a) was employed to cast two

composites containing Al-5wt% B, and Al-4wt% B-2wt% Mg. This casting unit is
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spring-driven for straightforward operation and uses flask sizes up to 88.9mm
diameter x 127mm long. Additionally, a 340g capacity transfer scoop was utilized to
pour the molten material, which subject to centrifugal forces, is driven into a mold
placed in the flask (Figure 3.3 b). This mold produced by investment casting
technique was preheated prior to centrifugal casting in order to facilitate the molten
metal into the mold. Normal preheat temperature was 400°C during 1 hour. The
centrifugal casting process was carried out with an initial (maximum) rotation speed
of 200 rpm while the pouring temperature of the material was 750 °C. The samples
finally obtained were cylinders with a 16 mm diameter and 20 mm length. This

rotation velocity is normal in centrifugal casting operation [45].

The centrifugal casting technique that was used reached a maximum rotation
speed which decreased gradually until it stopped; the rotation time and its speed
depended on the strength of the spring. This small scale (50-60 g of charge material)

equipment was suitable for laboratory experiments.
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Figure 3.3 Centifugal Casting Machine. a) Romanoff 79-049-T. b)Schematic drawing.

3.3 Sample Preparation

The cylindrical samples obtained from centrifugal casting process with
dimensions of 16mm in diameter and 20mm in length (Figure 3.4 a) were cut to
produce external, middle, and internal cross sections along the centrifugal casting
direction, as shown in Figure 3.4 b. This longitudinal mapping of the centrifugally
cast piece was done to identify the study zones on which the characterization of the
FGMs-AMCs would be conducted. The cutting of the samples was done with

BUEHLER IsoMet™ Low Speed Saw.

The whole metallographic procedure was carefully documented for
reproducibility purposes. Grinding, the first step of the metallographic preparation,

was carried out with a series of 320, 400, 600, and 800 grit SiC paper using water as
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the coolant/lubricant. Next a first step of polishing was carried out using 3 pm
diamond suspension (Struers™ DP), and lubricant (Struers™ DP) on a short felt
cloth (Struers MD-MOL™) followed by final polishing with a SiO, emulsion (Struers™
OPS) on short felt cloth (Struers MD-CHEM™). For the metallographic preparation

BUEHLER Alpha & beta grinder—polishers were used.

Centrifugal
Casting

Centrifugal
Casting

% 4 %

Internal Middle External
Zone Zone Zone

Figure 3.4 Centrifugally Cast Piece a) Final piece. b) Mapped longitudinal zones

The grinding and polishing steps produced smooth and scratch-free surfaces.
These surfaces were finally cleaned in a Cole- Parmer® 8890 ultrasonic cleaner in

ethyl alcohol as solvent.
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3.4 Characterization

3.4.1 Microstructure

The microstructure analysis of these two Al-B, and Al-B-Mg composites was
performed using a Nikon Epiphot 2 inverted optical microscope. Figure 3.5 presents
the resulting microstructure with AIB, reinforcements embedded in the aluminum
matrix for a binary Al-5wt% B composite.
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Figure 3.5 Micrograph of the microstructure of a centrifugal cast Al-5%wt B composite. a)
Longitudinal section. b) Cross section.

As mentioned before, in the Al-B system the practical insolubility of boron in
solid and liquid Al turns the Al-rich alloy into practical AMCs reinforced with AlB;
particles [46]. This kind of AMC combines the low density of the Al matrix with the
high hardness of the aluminum diboride reinforcers. The AIB, diboride has a higher
density, 3.19 g/cm®[47], than liquid Al (approximately 2.4 g/cm?®) [48] at the semisolid

composite casting temperatures (> 700°C).
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3.4.2 Analysis of the Volume Fraction of Reinforcement

Figure 3.6 presents the distribution of reinforcement (AlBz) volume fraction
based on one measurement of representative part and obtained by quantitative
analysis performed manually. Naturally, the as-received and gravity cast AMC's
exhibited a uniform distribution of the reinforcement particles. The composite
samples produced by centrifugal casting showed higher densities of reinforcement
particles in the outer regions compared to the inner regions of the casting. This
occurs since the dispersed particles are segregated by centrifugal forces and the
thickness of particle-rich region is strongly influenced by the speed of rotation, local
solidification time and the density difference between the base alloy and the

reinforcement [8].

In addition, Al-Mg-B composite exhibited more significant reinforcement
particles segregation than the Al-B composite. As mentioned in chapter 2 this can be
attributed to that the lower density of Al-Mg molten alloy (approximately 2.375 g/cm?®)
[25], which provides more fluidity to the melt. On the other hand, it has already been
established that higher boron levels, i.e. higher diboride volume fractions, increase
the viscosity of the semisolid material [4]. This higher viscosity inhibits the movement
of the diboride particles, which causes a lesser gradient of diboride volume fraction

from the inner to the outer sections of the cast.
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Figure 3. 6 Measured volume fraction of reinforcement particles in the AMC samples
investigated in this study.

3.4.3 Superficial Rockwell Hardness and Vickers Microhardness Testing

The ASTM (American Society for Testing and Materials) standard test method
for Rockwell superficial hardness of metallic materials is issued under the fixed
designation E 18. In the Rockwell superficial hardness test the preliminary test force
is 3kgf (29N) and total test force are 15 kgf (147N), 30 kgf (294N), and 45 kgf
(441N). The standard indenters are the diamond spheroconical and the steel ball
indenters 1/16, 1/8, 1/4, 1/2 inch (1.588, 3.175, 6.350 and 12.70 mm) in diameter.
The Rockwell superficial hardness scale used on the Al-5wt% B and Al-4wt% B-

2wt% Mg composites was 15 HRW (15 kgf, 1/8 inch. indenter) [49].

Figure 3.7 shows the variation of superficial Rockwell hardness on cross-
sections of these AMCs measured for the aforementioned experimental conditions.
The results revealed that the value of superficial hardness increases as a function of

distance from the internal zone to the external zone in the experimental Al - 4wt.%B
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- 2wt.% Mg composite. The Al-5wt.% B alloy did not demonstrate this behavior
because the reinforcement particle gradient is not as apparent as the one observed

in the Al-Mg-B composite.

80 | @Al swt.uB
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Superficial Rockwell Hardness (HR 15 w)

AS RECEIVED GRAVITY INTERNAL EXTERNAL
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Figure 3.7 Rockwell superficial hardness (HR 15w) measured in the AMC samples investigated
in this study.

The ASTM E 384 standard test method is used to determine the
microhardness of materials. A Vickers microindentation test uses a calibrated
machine to force a pyramidal diamond indenter of specific geometry, under a given
load onto the test material surface; then the resulting rhomboid diagonals are
measured optically. The Vickers number is then obtained by dividing the applied
load in kilograms-force by the projected area of the indentation in square millimeters,

computed from the measurement of the mean of the measured diagonals [50].

In the specific Vickers microhardness test conducted on the Al-B and Al-B-Mg
composites, 50 gf was the test load: HVso The microhardness tester employed was

a Buehler-Micromet® II.
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Results of Vickers microhardness analysis selectively done on the Al matrix
and reported in Figure 3.8 are in agreement with the superficial Rockwell hardness
results. One could assume that the hardness of the matrix was not affected by
reinforcement particles. However, this behavior has not often been observed since
the values of Young’'s modulus and the thermal expansion coefficients in ceramic
and intermetallic compound particles are different from those of the metal matrix.
Hence, the residual strain energy caused by the stress field present in the metal
matrix of the FGMs, depends on the composition gradient. The mutual relation
among hardness, volume fraction of particles and strain energy can satisfy the
supposition that the hardness and strain energy are proportional to the composition

gradient [7].
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Figure 3. 8 Vickers microhardness (HVso) values measured on the matrices of the diffferent
AMCs investigated in this study.

The addition of magnesium to the aluminum matrix had significant effects on their

mechanical and microstructural properties compared with Al-B composites [29]. This
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occurs because magnesium has a very high solid solubility in aluminum and the rate
of precipitation of the supersaturated solid solution is low [25]. Furthermore, the high
purity Al-Mg binary alloys show a more rapid rise in tensile strength than in yield
strength, indicating that magnesium is promoting work hardening [25]. This explains
the higher values of microhardness in the matrix of Al-Mg-B composites with respect
to the matrix hardness of Al-B composites. These Vickers microhardness values are
in agreement with prior research [51]. The microhardness result of Al-B casting can
be attributed to its larger reinforcement particle size regarding Al-B centrifugally cast
composites. This particle size can be diminished owing to interaction between
particles during centrifugal casting. Even though the effect of reinforcement particle
size was not dealt in this study, its influence has already been analyzed in the

literature [10].

3.5 Pin - On - Disk Wear Testing

This test method covers a laboratory procedure for determining the wear of
materials during sliding using a pin-on-disk apparatus and is issued under the
standard ASTM G 99. For the pin-on-disk wear test conducted in this research, the
two specimens were a pin with a rounded tip, which is positioned perpendicular to a
flat circular disk (the test sample). A ball, rigidly held, is often used as the pin. The
test machine causes either the disk specimen or the pin to revolve about the disk
center. The sliding path is a circle on the sample surface [52]. The pin is pressed

against the disk at a specified load usually by means of an arm or lever and attached
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weights, as shown in Figure 3.9 a. A schematic drawing of a typical pin-on-disk wear

test system is illustrated in the Figure 3.9 b.

Unlubricated pin-on-disk configuration wear tests were conducted on the
external and internal zones of the centrifugally cast AMC’'s and on stationary
(gravity) cast specimens (disks). The wear tests were conducted at a constant
sliding speed of 0.0066 ms™. The counter-surface (pin) used was 3.175mm diameter
ball of AISI 410 martensitic stainless steel ball. The duration of the wear test and the
applied normal load were maintained at 45 min and 0.15N (15g), respectively, for all

tests. The total sliding distance under these conditions was 18.5 m.

The wear volume was calculated from topographical characterization of the
wear track. The track perimeters, widths, and depths were determined using a Nikon
SMZ 1500 stereoscope, a Nikon Epiphot 2 optical microscope, and a Nanosurf

easyScan'™ atomic force microscope (AFM) respectively.

F = The normal force in
the pin

d = ball diameter of the
pin

D = Disk diameter

R = Wear track radius

W = Rotation velocity of
the disk.

Figure 3.9 Pin-on-disk wear test system a) Unlubricated Pin-on disk tester. B) Schematic
drawing [51].
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3.5.1 Wear Volume and Wear Coefficient

The topographical aspects as well as the dimensions of the pin-on-disk
tracks such as perimeter, width and depth are presented in Figure 3.10. These
parameters allowed for the calculation of the wear volume on each sample. To
calculate the volume of material removed, The profile was assumed to be a triangle
based on optical microscope and AFM image data. Thus, the triangle area obtained

was multiplied by the track perimeter.

a b

Unaltered
Surface

100

Figure 3.10 Images of wear tracks resulting from pin-on-disk wear tests a) Wear track of Al-
4wt.%B-2wt.%Mg external zone of FGM b) Track width of Al-5wt.%B casting c) Track depth of
Al-5wt%B internal zone of FGM
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Figure 3.11 shows the volumetric wear results obtained from gravity-cast samples as
well as on the internal and external zones of the centrifugally cast samples of the Al-
5wt%B and Al 4wt.%B 2wt.%Mg. The smallest wear volume measured was
observed on the external zone of the FGMs. This is in agreement with the observed

higher volume fraction of boride phases in these outer regions.

0.014 4 @ Al 5%wt.B

0.012 - WAl 4%wt.B 2%wt.Mg

Wear Volume (mm %)

O T T
GRAVITY CASTING INTERNAL ZONE EXTERNAL ZONE
200 RPM 200 RPM

Figure 3. 11 Wear volume for the various AMC samples after undergoing pin-on-disk wear
tests under identical conditions.

On the other hand, the internal zone of the FGMs (more depleted of AlB,
particles) resulted in higher wear volume. The gravity-cast sample displayed a wear
volume loss in between those exhibited by the outer and inner regions of the
sample. Furthermore, the Al-4 wt.%B-2 wt.%Mg composite exhibited lower wear
volume on the external zone than the centrifugally cast Al 5wt% B alloy. This effect
is attributed to solid solution strengthening and precipitation hardening of metastable
Mg-containing phases. Table 3.1l shows the wear coefficients according to Equation

2.4, calculated for the samples exposed to unlubricated pin-on-disk wear tests.
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WEAR COEFFICIENT RESULTS (mm®/N-m)

Al 5%wt.B Al 4%wt.B

2%wt.Mg
CASTING 0.001879 0.002342
INTERNAL ZONE 200 RPM 0.002958 0.004612
EXTERNAL ZONE 200 RPM 0.001246 0.000897

Table 3. 1 Calculated wear coefficient for the various AMC samples.

Wear test results, and wear track analysis are consistent with the
microstructural gradients observed in these alloys. In effect, the higher volume
fraction of reinforcing boride particles in the outer regions (external zones) of the
centrifugally cast samples translates into a higher overall wear resistance in those
regions. On the other hand, the internal regions (internal zones) are fairly depleted
of boride reinforcement particles and, thus, are subject to high wear rates. Finally, as
expected, the control sample (gravity-cast composite) displayed an intermediate
behavior as the volume fraction of diborides is evenly distributed throughout the

composite mass.

In general reinforcing AIB, particles (with higher bulk density than liquid
aluminum) segregate towards the surface regions as a result of the inertial forces
created the centrifugal casting process. Additionally, hardness values, wear test
results, and wear track analysis are consistent with the microstructural gradient
observed in Al-B-Mg composites. In effect, the higher volume density of reinforcing
boride particles in the outer regions of the centrifugally cast samples translates into a
higher hardness and higher overall wear resistance on those regions. On the other
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hand, the internal regions are fairly depleted of boride reinforcement particles and,
thus, are subject to higher wear rates. As expected, the control sample (gravity-cast
composite) displayed an intermediate behavior as the volume fraction of diborides is
evenly distributed throughout the composite mass. On the other hand Al-B
composites did not fully display this behavior. Superficial hardness and
microhardness were lower that Al-Mg-B composite and reinforcement particles

gradient was not particularly relevant.

62



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

4. PROCESSING AND CHARACTERIZATION OF FGM Al-B-Mg
COMPOSITES

The previous chapter dealt with the development of a processing and
characterization methodology for FGM — Al-B and Al-B-Mg composites, from those
results, the beneficial effect of magnesium in the composition gradient and wear
resistance of these AMCs becomes apparent. In the present chapter further
experimentation on Al-B-Mg composites was performed. In this case centrifugal
casting was applied to experimental Al - 2wt%Mg - 1, 2, 3 and 4wt%B alloys.
Qualitative and quantitative microstructural characterization methodologies are
developed. Quantitative image analysis by Image J software Version 1.34s (see
Appendix A) allowed measuring the reinforcers and pores volume fraction for Al-B-
Mg composites in two conditions: gravity casting condition and at 0, 5, 10 15 and 20
mm from the internal centrifugally cast samples. In addition, matrix grain size and
reinforcement particle size were determined by the Image J software. Superficial
Rockwell hardness and Vickers microhardness were also measured on the
composites and related to the properties previously measured. Pin-on- disk wear
testing was carried out on Al-B-Mg samples (disks) in the two conditions described
earlier. Morphological characterization of worn surfaces by scanning electron
microscopy (SEM) was done on Al-2wt.%Mg-1wt.%B in both conditions, i.e.
centrifugally cast and gravity cast. Figure 4.1 displays the steps of this experimental

procedure used to process and characterize the Al-B-Mg composites.
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INVESTMENT CASTING| g Wax Models q Gypsum Melting Wax Mold
(autoclave) 1

»
»”| (1.6cm @, 3.0 cm length) "1 Hydrostone Molds g
v
CENTRIFUGAL o | °/Initial rotation velocities (0,and 300 rpm)
CASTING »| + Melting Temperature 850°C
v
SAMPLE o | Cross sections
CUTTING —»| (0,5,10, 15, 20 mm)
v
METALLOGRAPHIC »| CHARACTERIZATION
PREPARATION ” (FGM and AMC)

l l l l Y
Microstructure Volume fraction of Matrix Grain Size Superficial Rockwell Unlubricated
(Optical microscopy) reinforcement particles and Hardness and Wear Test
and Pores Reinforcement Vickers Pin-on-disk
Particle Size Microhardness
JV

« Wear volume.

» Wear Coefficient.
*Morphological
Characterization of
Waorn Surface

Figure 4. 1 Diagram showing the experimental procedure sequence to Al-B-Mg composite.

4.1 Investment casting

The investment casting process used to obtain a final mold for the semisolid
Al-B-Mg composite was the same as the procedure established in the previuos
chapter. However, for the work presented the cast piece produced had larger

dimensions. For this reason, the wax model dimensions (wax pattern) were 16 mm

and 30 mm in diameter and length respectively.
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4.2 Centrifugal Casting Process

The centrifugal casting technique carried out to obtain Al-B-Mg FGMs was
similar to the method described on the section 3.2. Nevertheless, the centrifugal
casting process was conducted with an initial (maximum) rotation speed of 300 rpm.
This rotation speed is considered a normal operation velocity [45]. Furthermore the
pouring temperature of the molten material was 850 °C. This temperature was
established because mold filling problems occurred during experimental set up,
provoked by very fast cooling of the semiliquid material. In addition, it is important to
mention that the dimensions of the final cast pieces were increased. The samples
finally obtained were cylinders with a 16 mm diameter and 25 mm length (see Figure

4.2 a).

4.3 Sample Preparation

The cylindrical samples centrifugally cast (Figure 4.2 a) were cut to generate
0, 5, 10, 15, 20 mm cross sections along the centrifugal casting direction, as shown
in Figure 4.2 b. This longitudinal mapping of the centrifugally cast piece was made to
categorize the study zones on which the characterization of the Al-B-Mg centrifugally
cast would be conducted. The cutting of the samples was done with a Buehler
IsoMet™Low Speed Saw. The resulting samples of the cutting process were
processed according to metallographic preparation procedure described in

chapter 3.
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b
Centrifugal
Casting

Figure 4. 2 Centrifugally Cast Piece a) Final piece b) Mapped longitudinal zones

4.4 Characterization

4.4.1 Microstructure

The microstructure analysis of the Al-B-Mg composite was performed using a
Nikon Epiphot 2 inverted optical microscope. Figure 4.3 presents the resulting
microstructure with AIB; reinforcements embedded in the aluminum matrix for a Al-
2wt.%Mg — 1wt.%B composite. It can be observed that equilibrium precipitate
AlsMg2(B) is present as well. This is one of stable phases in the Al-Mg system [27].
In addition, magnesium has a very high solid solubility in aluminum; this solubility
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decreases to approximately 1.7 wit% at room temperature, but the rate of

decomposition of the supersaturated solid solution is very low [25].

y 3
AlB2 —p Al3Mg2
L 10 pm

Figure 4.3 Microstructure of a centrifugal cast Al-2wt%Mg-1wt%B composite.

Thermodynamic and physical properties of the Al-Mg system are important for
the production of these light, multicomponent alloys. The increasing magnesium
content produces an increase in yield strength and ultimate tensile strength while the
elongation falls with small Mg additions [25]. Advantages of the Al-B system and the

importance of AMCs reinforced with AIB, particles were mentioned in prior chapters.

4.4.2 Volume Fraction of Reinforcement and Pores

The micrographs shown in Figure 4.4 present the distribution of AIB, particles
along Al-2wt.%Mg-2wt.%B alloy centrifugally cast at 300 rpm. Figure 4.5 illustrates
the results of reinforcement volume fraction obtained by Image J quantitative

analysis to Al-B-Mg FGMs (see Appendix B). In the composite with 1%B, noticeable

67



Z. Humberto Melgarejo P, Master Thesis, UPR-RUM. 2006

segregation of reinforcers was observed starting at 15 mm, while the diboride

volume fraction reaches a maximum in the 20 mm section. Al-B-Mg composites with

2 and 3%B showed AIB; particles displacement from 10 mm to 20 mm sections. At

4%B the composite displayed dispersion of reinforcement particles from 5mm to

20mm.

O mm zone 10 mm zone 20 mm zone

Figure 4. 4 Micrographs of Al-2wt%Mg-2wt%B FGM mapped longitudinal sections

Figure 4.5 Measured volume fraction of reinforcement particles in the FGM samples as a
function of distance.
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The segregation of AIB, particles occurs due to the centrifugal force applied to
the semisolid mixture of molten metal and dispersed particles, which leads to the
formation of the desired composition gradient. Here, the gradient is controlled mainly
by the differences in density between the matrix and the dispersed material [53].
Furthermore, percentage of boron affected the segregation in these FGMs. This can
be explained by the composition gradient induced by centrifugal casting. The
segregation is affected by the rotational velocity, density and size of the particles,
the viscosity of the semisolid material, mean volume fraction of particles, and the
local solidification time [53]. In particular the higher boron levels increase the

viscosity of the semisolid material by increasing the number of solid AIB; particles.

Figure 4.6 shows the reinforcement volume fractions in a Al-2wt.%Mg -B
gravity casting alloys when its boron percentage varies from 1 to 4wt%. These
gravity casting composite values are identified as intermediate values in relation to
reinforcers volume fraction of the FGMs. Furthermore these results confirmed
guantitatively the influence of boron in the formation of aluminum diborides into Al-

Mg-B alloy.

Variation of pore levels in the Al-B-Mg FGMs is illustrated in Figure 4.7. This
variation determined by Image J (Appendix C) helped to identify that in the
centrifugally cast composite Al-2wt.%Mg-1wt%B a lower number of pores are
present. However, the porosity increases when the volume fraction of reinforcement

increases in the 10 mm section. A similar tendency was revealed in the 2 and
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3wt%B composites. Furthermore, these composites exhibited more porosity than the
Iwt.%B. The 4wt.%B composite exhibited the maximum pore percentage with

respect to the other three conditions.

30

Volume Fraction of Reinforcement

Boron Percentage

Figure 4.6 Measured volume fraction of reinforcement particles in the gravity cast samples as
a function of %wt.B.

Porosity = -0.8656+0.6579*x+0.0882*y-0.0841*x*x-0.0024*x*y-0.002*y*y

2.0
1.5
M :
Porosity 1.0 [Jos
’ B o

Wt..% boron

Distance (mm)

Figure 4.7 Measured volume fraction of pores in the FGM samples as a function of distance.
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The measurements of porosity shown in Figure 4.8 did not reveal a large variation in
the AI-B-Mg gravity cast composites when the boron percentage increased. In
addition gravity cast alloys exhibited lesser porosity than centrifugally cast
composite. This might be essentially due to the lower quantity of trapped air in slow
pouring condition adopted during gravity casting compared with the stirring

experienced in centrifugal casting.

0.8 |

0.6 |

) —

0.2

Volume Fraction of Pores (%)

Boron Percentage

Figure 4. 8 Measured volume fraction of pores in the gravity casting samples as a function of
%wt.B.

In agreement with the results one can observe some influence of reinforcement
particles upon porosity. The increase in porosity with the increasing amount of
particulates could be due to the increase in the apparent viscosity of the semisolid
composite, limiting its ability to discharge trapped air, and the inability of the
disintegrated molten melt to infiltrate the micrometer sized crevices in the

inefficiently packed ceramic particles [5].
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Porosity in a casting is attributed to both solidification shrinkage and trapped air. In
addition, any residual porosity will have a deleterious influence on mechanical
properties of FGMs. It has been observed that the magnitude of the modulus of
elasticity decreases with volume fraction porosity. It can occur due to porosity
reduce the cross-sectional area across which a load is applied and acts as stress
concentrators and when the pore reaches the critical value, a crack forms and
propagates since there are no large energy-absorbing processes. There are several
factors affecting porosity such as pouring rates too slow, low casting temperatures,

and filling mold problems among others.

It is therefore important to determine the level of porosity presents in these FGMs.
The effect of the centrifugal casting process on porosity distribution is critical to

establish its potential influence on final mechanical properties.

4.4.3 Superficial Rockwell Hardness and Vickers Microhardness Testing

The standard method for the determination of superficial Rockwell hardness
is ASTM E 18. The superficial Rockwell hardness used on Al 2wt.%Mg-1,2,3 and

4%B composites was 15 HRW ( 15 kgf, 1/8 inch. indenter).

Figure 4.9 displays the superficial Rockwell hardness results measured on
the Al-B-Mg FGMs for the experimental conditions previously established. The
results indicate that the value of superficial hardness increases as a function of the

distance in the experimental Al-B-Mg alloys. We found a direct relation between the
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superficial Rockwell hardness and the volume fraction of reinforcers. Thus, the
superficial Rockwell hardness starts increasing from 10 mm to Al-B-Mg composite
with 1wt.%B. At 2 wt.%B this hardness increases from 5 mm while 3 and 4wt.%B
achieved the maximum hardness value at 5mm, which remains unchanged until the
end of the casting.

Superficial Hardness = 42.5329+2.0832*x+1.812*y+0.9508*x*x-0.3456*x*y-0.0008*y*y

Bl 745
> Il 70
[ 64
58
N 52
B 46

Rockwell
Superficial
Hardness

..% boron

Distance (mm)

Figure 4.9 Rockwell superficial hardness (HR 15W) measured in the FGM samples as a
function of distance.

Figure 4.10 shows evidence of the direct relation between the superficial
hardness and boron percentage on Al-B-Mg gravity cast composites. This relation is

function of reinforcement volume fraction too, as explained earlier.

The ASTM E 384 standard test method was employed to determine the

microhardness in the FGMs and gravity casting composites. In the Vickers
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microhardness tests a 50 g¢f load was applied (HVso). The microhardness tester

employed was a Buehler-Micromet® II.

75

60 T T

Rockwell Superficial Hardness (15W)

Boron Percentage

Figure 4.10 Rockwell superficial hardness (HR 15W) measured in the gravity casting samples
as a function of %wt.B

Results of Vickers microhardness analysis made on the Al matrix of Al-B-Mg
FGMs and depicted in Figure 4.11 confirm the mutual relation among volume
fraction of particles, superficial Rockwell hardness, and Vickers microhardness
measurements. Furthermore, although superficial hardness and microhardness
increase toward the end of the casting this trend is less noticeable in Hy
microhardness values. This can be explained because of a larger influence of the
particle hardness than matrix hardness in mechanical properties of these

composites since diborides are harder than aluminum matrix.
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Vickers Microhardness = 21.4337+6.2628*x-0.2495*y-0.3039*x*x+0.0295*x*y+0.0272

60

50

Vickers
Microhardness 40

30

20

Distance (mm)

Figure 4.11 Vickers microhardness (HVso) values measured on the matrices of the different
FGMs as a function of distance.

The Vickers hardness results presented in Figure 4.12 indicate the direct
influence of percentage of boron upon microhardness values of Al-B-Mg gravity
casting alloys specially, at 1 and 2wt.%B. That is, the greater the boron quantity,
larger is the microhardness value. This relation can be explained by the large
difference in coefficient of thermal expansion between Al and the particles which
leads to an increase in the dislocation density in the matrix, thus resulting in
hardening of the matrix; this effect has been shown to increase with the increasing

presence of ceramic particles [5].
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Superficial Rockwell hardness and Vickers microhardness values determined
the influence of matrix and reinforcing particles and how the interaction of these
phases affected the overall mechanical properties of AMCs. Even tough, initially the
aluminum matrix hardness was not considered as a factor into material composite
hardness, Vickers microhardness measurements enabled to demonstrate a direct
relation between matrix and reinforcer phases. On the other hand, the superficial
Rockwell hardness measures showed the major effect of solid particles respect with

the matrix on mechanical properties of FGMSs.

50

45

40 -

Vickers Microhardness

Boron Percentage

Figure 4.12 Vickers microhardness (HV50) values measured on the matrices of the different
gravity casting samples as a function of %wt.B.

4.4.4 Reinforcement Particle Size and Matrix Grain Size

The micrograph showed in Figure 4.13 demonstrates a typical AlB; particle, in
Al-B-Mg composites. Nevertheless, additional energy dispersive spectroscopy (EDS)
and electron microprobe analysis (EMPA) indicated that, when Mg is present in the

composite, it diffuses in the AIB, particles to substitute Al atoms and form an AlMgi-
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xB2 compound. Additionally, it is believed that this AlyMgi.xB> compound is harder
than AIB,. These assumptions have to be corroborated by means of nanoindentation

studies currently under way.

Figure 4.13 Micrograph of the reinforcement particle size of a centrifugal cast Al-2wt%Mg-
4wt%B composite.

Quantitative analysis made with J (Appendix D), determined distribution of
reinforcement particles size in Al-B-Mg FGMs and gravity cast composites, as
shown in Figures 4.14 and 4.15. The results of centrifugally cast composites do not
demonstrate a specific variation in the particle size of the reinforcers in spite of the
interaction of the particles under the centrifugal force action. The small particle size
(aprox. 5 um) found in this study can be the reason for these results because the
particle size was not affected, since the potential interaction volume per particle with
matrix and other particles is lower in small particles than for large particles.
Additionally, gravity cast composites showed no remarkable changes in the
reinforcement particle sizes, when the boron percentage is increased. The effect of

centrifugal casting on particle size provoked by higher centrifugal velocities, lead to
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decreased mean patrticle size [10]. However, further considerations are necessary in
order to understand the reduction in particle area fraction and in mean particle size,

particularly for less severe casting conditions.

10 g

Particle Size (um)

0 \ \ T
0 5 10 15 20

Distance (mm)

—0— 1%B —-0--2%B --&--3%B ---x--- 4%B

Figure 4. 14 Reinforcement particle size values measured on the FGM samples as a function of
distance.

4.5

Particle Size (um)

25 b 1

Boron Percentage

Figure 4. 15 Reinforcement particle size values measured on the gravity casting samples as a
function of %wt.B.
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Figure 4.16 shows a micrograph of grains in the matrix of a Al-B-Mg gravity
cast composite. The matrix grain size results obtained by quantitative image analysis
(Appendix E) done on both the FGMs and gravity cast composites did not reveal any
considerable difference. The uniform distribution of the matrix grain size of Al-B-Mg
centrifugally cast alloys is shown in Figure 4.17. Similar behavior was found in the
gravity cast composite, as illustrated in Figure 4.18. The small difference in grain
size detected between FGMs and gravity cast alloys (measure of dispersion is large)
may be due to the slower solidification rate in gravity cast composites than in

centrifugally cast alloys [8].

N\

E j

Figure 4.16 Micrograph of the matrix grain size of a gravity casting Al-2wt%Mg-4wt%B
composite.
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Figure 4.17 Matrix grain size values measured on the FGM samples as a function of distance
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Figure 4.18 Matrix grain size values measured on the gravity casting samples as a function of
%wt.B.
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4.4.5 Possible Scenario of Liquid-Particle Flow and Microstructure
Formation of Al-B-Mg Composites Centrifugally Cast

The transport phenomena occurring in solidification processes of FGMs are
complex due to different factors such as the transport of fluid, heat and solute (which
governs the migration of particles in a liquid matrix), and the interactions of particles

with the solidifying matrix [54].

Various processing parameters, such as crucible furnace temperature, mold
heating furnace temperature and velocity of mold rotation can significantly influence
the composition gradient in the FGM. Because of the high rotational speed of the
mold experimental estimation of the solidification time and temperature distribution
during solidification through heat-and mass-transfer analysis is a complex problem

under realistic condition for this centrifugal method [55].

The above statement indicate that any further conjecture about solidification
mechanism involving liquid-particle flow and microstructure formation of Al/AIB;
matrix composites can be speculative in nature for this centrifugally casting process.
Figure 4.19 illustrates the liquid-particle laminar flow filling the mold (due to the initial
rotational velocity) through centrifugal casting method. Additionally it is assumed that
the motion of the particles is stopped by the liquid front; the particles do not move in
the mushy zone of the casting and they are not rejected by the solidification front.
The first assumption is reasonable due to the rapid increase of the viscosity of the

semisolid composite due to the forming solid phase fraction. It is to be noted also
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that the viscosity of the liquid varies with temperature which will affect the
segregation velocity of the particles.

AlB; particles
A

T 7

— 33 O
o o o — Mold
O—O0—0—

2720777777777

A
Aluminum matrix

Ninnmme

N

Figure 4. 19 Liquid-particle laminar flow filling the mold.

Three interlacing phenomena have to be considered when a liquid containing
suspended particles solidifies in a mold rotating at high velocity: a) interaction
between the solidification front and the moving particles, b) variation of the viscosity
of the liquid before complete solidification and c) possible interaction among
particles in the liquid. For the sake of simplicity, only the first one will be considered

in the following discussion.

As mentioned previously, the Al/AIB, matrix composite system offers the
advantage that the reinforcements are appropriately incorporated in to the molten
alloy due to excellent wettability between the borides (acting as reinforcing particles)
and the aluminum melt. Al-rich alloys of this system are used as master alloys for
grain refining of aluminum alloys [12]. Since AIB, phase present in these alloys is a

catalytic substrates for the early crystallization of the aluminum phase [13].
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The production of an equiaxed zone requires the existence of small
crystallites, or nuclei, in the bulk during freezing. Constitutional supercooling driven
heterogeneous nucleation is one mechanism for the provision of these nuclei.
However, constitutional supercooling does not to drive the nucleation of equiaxed
grains except in the presence of a grain refiner or other efficient substrate [56]. As

mentioned, AIB; particles promote heterogeneous nucleation.

Figure 4.20 a. shows the growth of equiaxed grains in a preferential zone of a
casting piece as a result of the segregation of AIB, particles by centrifugal forces.
This particle-rich region promotes the formation of an equiaxed region produced by
heterogeneous nucleation due to the reinforcement particles. Moreover, additional
AIB, particles away from the particle-rich region could also be promoting the
formation of equiaxed grains. As the liquid metal becomes in contact with mold
walls, solid nuclei form, creating a chilled zone [56]. On the other hand, high
undercooling and high solidification rates generated through the centrifugal casting
process will tend to form dendrites at the liquid-solid interface, as shown in Figure

4.20 b.

Figure 4.20 c. shows a schematic of the resulting structure of equiaxed solidification
where the reinforcement particle is much smaller than the grain size. Furthermore,
there is good wetting between particles and liquid, which implies particle engulfment,
resulting in a uniform distribution of particles within the grains. As it was mentioned

earlier the nucleation of aluminum matrix grain is favored by AlB; particles; for this
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reason this phenomenon is observed preferentially where most particles were

segregated.
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Figure 4.20 Schematic of microstructure zone formation in centrifugally cast piece. a)
Equiaxed zone preferentially formed in the outer zone by effect of AIB2 particles. b) Growth of
a dendrite. c) Resulting structure of crystal growth in equiaxial solidification.
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4.5 Pin - On - Disk Wear Testing

The test method used for determining the wear of Al-B-Mg composites is
based on standard ASTM G 99. The procedure to carry out this test was explained

in the previous chapter.

Unlubricated pin-on-disk configuration wear tests were performed at 0, 5, 10,
15, and 20 mm from the edge of the centrifugally cast AMC’s and on gravity cast
samples (disks). The wear tests parameters were: constant sliding speed, 0.0060
ms™; counter-surface (pin) 3.175mm diameter ball made of AISI 410 martensitic

stainless steel ball; time 45 min, applied normal load 0.15N (15g). The total sliding

distance under these conditions was 16.5 m.

4.5.1 Wear Volume and Wear Coefficient

Topographical images of the pin-on-disk tracks obtained by AFM and
presented in Figure 4.21 revealed qualitatively and quantitatively the wear response

of centrifugally cast Al-B-Mg composite.

The assessment of the volume of removed material as determined by the

topographical dimensions of the wear track was developed in agreement with the

procedure established in the section 3.5.1.
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Figure 4. 21 AFM images of tracks depth resulting from pin-on-disk wear tests on Al-2wt%Mg-
1wt%B FGM a) 0 mm zone. b) 10 mm zone. ¢) 20 mm zone.

Figure 4.22 shows the wear volume results measured in the Al 2wt.%Mg 1,
2, 3, and 4wt.%B centrifugally cast samples. The highest wear volume was observed
on the 0 mm section of the FGMs. The wear rate decreases as a function of the
distance, where the 20 mm section has the smallest wear volume. These results are
compatible with the higher volume fraction of boride phases found in the 15 and 20
mm sections. This corroborates that the wear resistance of the FGMs is controlled
by the boron percentage, (as the diboride volume fraction) since, the results
displayed larger wear in Al-B-Mg composites with 1wt.%B than those with 3 and

4wt%B. The results of wear volume in gravity cast composites shown in Figure 4.23
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support the previous statement. Besides, these results exhibited an intermediate

range of wear volume values regarding those in the opposite zones of FGMs.
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Figure 4.22 Wear volume for the various FGMs-AMCs samples after pin-on-disk wear tests
under identical conditions.
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Figure 4.23 Wear volume for the various Gravity Casting - AMCs samples after pin-on-disk
wear tests under identical conditions.
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Wear coefficient results provided in Table 4.1 were calculated using equation
2.4. These results exhibited a similar tendency as the data reported previously: low
values of wear coefficient obtained for the 20mm sections of FGMs indicated better
wear resistance compared to the gravity cast composites. This result is rather

obvious since the wear coefficient depends directly on the wear volume.

WEAR COEFFICIENT RESULTS (mm°®/N-m)

Al-2wt%Mg-  Al-2wt%Mg-  Al-2wt%Mg- Al-2wt%Mg-

Sample 1Wt%B 2Wt%B 3Wt%B AWt%B
FGMs - 0 mm zone 0.0030 0.0034 0.0022 0.0029
FGMs - 5 mm zone 0.0026 0.0029 0.0021 0.0014
FGMs - 10 mm zone 0.0019 0.0005 0.0011 0.0013
FGMs - 15 mm zone 0.0014 0.0007 0.0007 0.0007
FGMSs - 20 mm zone 0.0007 0.0006 0.0009 0.0007
Gravity Casting 0.0016 0.0016 0.0015 0.0012

Table 4.1 Calculated wear coefficient for the various AMC samples.

Wear test results of the FGMs and gravity cast composites demonstrated a
great dependence on the composition gradient. Conversely, higher volume fraction
of reinforcing boride particles translates into a lower overall wear rate. A similar

relation was found between wear rate and hardness.

4.5.2 Morphological Characterization of Worn Surface

Morphological characterization of worn surfaces samples was performed by
scanning electron microscopy (SEM) using a JEOL-JSM 5410 LV. Backscattered
electron image (BEI) was the technique used to analyze the morphology of the wear

track in the Al-2%wt.Mg-1wt.%B centrifugally cast and gravity cast composites. This
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technique was useful for our particular application since backscattered electron
detector may be used as an additional source of topographic contrast information
[57]. In addition at low magnification, backscattered electron micrographs can give a
better impression of the surface topography than secondary electron micrographs

[58].

The worn surface morphology of the 10mm cross section FGM shown in
Figure 4.24 a is characterized by uniform wear track with large cavities caused by
matrix detachment. Furthermore, wide plastic deformation with plowing grooves are
aligned with the sliding movement and flat smooth regions. This morphology occurs
due to the low presence of aluminum diboride particles in the sample, which caused

a high deterioration in the aluminum matrix.

Figure 4.24 b presents the BEI of the track on the 20mm section of
centrifugally cast composite. The uneven wear track surface displayed AlB; particles
fragments detached on the matrix surface; at the same time it evidenced some
matrix detachment and the presence of dispersed adherent tribolayers with smooth
appearance. Both, the protruding aluminum diboride particles and the adherent

tribolayers explain the high wear resistance of the FGM [9].

Morphological analysis on worn surface of the Al-B-Mg gravity casting shown
in Figure 4.24 ¢ demonstrated a combination of the wear modes present in FGMs.

Large cavities caused by matrix detachment and reinforcing particles as load
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bearing elements are the prevalent mechanisms. Fragments lost from the mating

surface can be picked up and observed at the end of the groove at which they have

formed (see “A” in Figure 4.24 c) [43].

=———100u

[

Figure 4. 24 Wear Track backscatter electron image of Al- 2wt %Mg- 1wt.% B alloy, a) FGM
10mm zone, b) FGM 20mm zone, c) Gravity casting.

According to the SEM images it can be concluded that the 10 mm section in

FGM showed a larger wear rate compared with the 20mm section of centrifugally
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cast sample and gravity casting composite. It corroborates the observation that wear

resistance can be improved by increasing the volume fraction of hard particles [43].

Characterization of worn surfaces indicated that the combined effect of
reinforcing particles as load bearing elements and the formation of protective
adherent tribolayers plays a decisive role on the friction and wear properties of
aluminum matrix composites [9]. In addition, the reinforcer fragments detached from
the composite surface can be transferred to the mating surface due to adhesion.
Further sliding causes more fragments to be formed by either of the two
mechanisms. After certain time this attached fragment became loose and separate
from the surface [44]. It can be concluded that Al-B-Mg composites exhibited two
dominant types of wear; abrasive and adhesive. The oxidational wear requires
additional analysis to be detected but it frequently takes place when the humidity in
the environment is high or when high temperatures are reached during the wear

process.

In closing, composition gradient was observed in Al-B-Mg composites when
they are subjected to centrifugal forces upon casting. Aluminum diborides particles
(denser than liquid Al) are displaced towards the outer regions as a result of the
inertial forces. In addition, superficial hardness and Vickers microhardness values
showed a direct linear relation with respect to the volume fraction distribution of
reinforcement. Wear test results revealed a dependence of these composites on

both microstructural gradient and hardness. In effect, the higher volume density of
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reinforcing boride particles in the 20 mm sections of the centrifugally cast samples
caused a higher overall wear resistance on those regions, while the 0 mm sections
experienced the highest wear rates. Gravity cast composites demonstrated an
intermediate wear volume values with respect to opposite zones of FGMs, while
volume fraction of diborides is uniformly dispersed along the composite mass.
Results of reinforcement particle size and matrix grain size did not reveal a
significant difference in both centrifugally cast composites and gravity cast alloys.
Morphological analysis of worn surface by SEM displayed two wear modes: abrasive
and adhesive. These types of wear lead to matrix detachment with plowing grooves,
AlB; particles detached and sitting on the matrix and the formation of adherent

tribolayers, which contribute to improve the wear resistance of Al-B-Mg composites.
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5. CONCLUSIONS

1. A centrifugal casting technique was developed to manufacture functionally

graded aluminum matrix composites.

2. Centrifugal casting process permitted to obtain functionally graded aluminum
matrix composites reinforced with aluminum diboride particles from

experimental Al-B-Mg composites.

3. Higher composition gradient was observed in external zone (20mm) of Al-B-
Mg composites compared with Al-B composites, which corroborated the

beneficial effect of Mg in the FGMs-AMCs.

4. Superficial Rockwell hardness and Vickers microhardness results of Al-B-Mg
centrifugally cast composites demonstrated to be influenced by the
microstructure gradient where higher volumen fraction of AIB, particles

involves larger hardness.

5. Reinforcement particle size and matrix grain size results of FGMs were not

significantly affected by centrifugal forces as compared with gravity casting

composites.
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6. Wear test and wear coefficient results were consistent with the composition
gradient observed in centrifugally cast composites where higher volume of

reinforces translated in smaller wear rate.

7. Morphological analysis of worn surface by SEM exhibited two wear modes:
abrasive and adhesive. These types of wear lead to the detachment of
aluminum matrix and AlB; particles and the presence of adherent tribolayers,

which contributed to improve the wear strength of Al-B-Mg composites.
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6. RECOMMENDATIONS

Other materials phenomena found during this research not fully reported in
this thesis took place, would require both extensive and in-depth study to provide
complementary information. In addition, other topics around of this subject will assist
to a better comprehension for this new functionally graded material. Therefore, |

recommend emphasizing the following themes:

v Fabrication of the new FGMs with appropriate dimensions for mechanical
testing and full characterization of the mechanical properties of these

composites.

v Development of numerical model to predict the redistribution of the boride

particles in the molten aluminum matrix for different rotational speeds.

v Production a new FGMs doing use of other metal diborides particles (Nb, Hf,
Zr, Ti, Cr).
v Full study of the effect of magnesium on Al-B alloys and possible formation of

(Al,MQ@)B. as reinforcement particle.

v General corrosion behavior of the Al-B-Mg FGMs.

v Experimental determination of the temperature gradient during centrifugal

casting and validation with theoretical model.
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APPENDIX

APPENDIX A. Image J Application Version 1.34s for Microstructure
Quantitative Analysis

The open source nature of Image J (Figure A.1) makes it a prime choice for
any researcher working with cost restrictions. Also it is very versatile software with
many capabilities that are not explained in this manual. It has a website
(http://rsb.info.nih.gov/ij/) dedicated to the program and forums that help keep the

researchers connected. The web site maintains a database of plug-ins that helps the
analysis process. The program also has a record option that creates macros of
different processes that the user produces. This becomes very handy when the user
needs to complete a series of commands repeatedly for a large number of images.

Figure A.1
Drop Down Menus

Figure A.2 presents a series of print-screen shots of the program’s main drop

down menu. It has File, Edit, Image,

File Edit Image Prc
FMew... CArl+M
Qpen... Cirl+0
Open Samples 4
Open Recent 4
Import 4

Close CArl+iny
Save Cirl+5
Save As L
Revert Cirl+R

Page Setup...
Frint... Cirl+P

Quit

Figure A.2
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Also as part of the drop downs menus Figure A.3 presents the options

Process, Analyze, Plug-in, Window and Help.

Figure A.3
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APPENDIX B: Quantitative Analysis of Volume Fraction Procedure

1. General Procedures for one type of Reinforcements:

1.1. Processing the Image for Analysis:

Even if the user creates an image of pristine quality, the image still needs
some level of processing so that some of the analysis commands can work properly.
There is a need to create a level of quality that improves the results even more than
when the researcher took the time and effort to meticulously capture the best images
under the circumstances (type and properties of the material and the equipment at
hand). For images taken in an optical microscope with a magnification of 50X, the
following are a series of procedures that the user can complete to process the
photographs. Note: It is assumed in this procedure that the user already opened the

software and the image of interest to do the following processing procedures.

1.1.1. Eight Bit Images
First, it is necessary to transition the image into an 8 bit one (a grayscale
photograph) instead of a color RGB image, which is the image format that the

microscope produces. Go to the drop-down menu Image>Type>8 bit (Figure B.1)

Figure B.1
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1.1.2. Enhance contrast (Figure B.2)

This option essentially enhances the contrast (hence the name). When you
press the command button a pop up menu will appear. The researcher will need to
enter a saturated pixel value. The Saturated Pixels is the number that determines
the pixels in the image that are allowed to become saturated. If the researcher
increases this value, it will increase the contrast. The saturated pixel value is set at a
standard value of 0.5 and the researcher should use this value. To use the

command go to Process>Enhance Contrast and select “ok”.

Figure B.2
1.1.3. Normalize Image (Figure B.3)

Normalizing the image will recalculate the pixel values of an image so the
range of the image is equal to the maximum range. The maximum range is 0-255 for
8-bit images. This normalization process can not be done for RGB images. To use
the command go to Process>Enhanced Contrast and select the “Normalize” check

box and then “ok”.

Figure B.3
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1.1.4. Find Edges (Figure B.4)

It performs a 2-D spatial gradient measurement on the image and highlights
regions of high spatial frequency that correspond to edges. It is used to find the
approximate absolute gradient magnitude at each point in a grayscale image.
Spurious noise will appear afterward on the resulting image, but they can be

removed by thresholding. To use the command go to Process> Find Edges.

Figure B.4

1.1.5. Threshold (Figure B.5)
This command converts a grayscale image to black and white. The threshold
level is determined by the histogram of the entire image. To use the command go to

Process> Binary> Threshold.

Figure B.5
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1.1.6. Watershed (Figure B.6)
This segmentation command separates apart particles that touch in an image. It
requires a binary image containing black particles on a white background. To use

the command go to Process> Binary> Watershed.

Figure B.6

1.2. Image Analysis

The “analize particles” command counts and measures objects in binary or
thresholded images. To use it go to Analyze>Analyze Particles. The user can press
the esc key to abort this process, and to restart the process the user must close the
pop-up windows of results and summaries that shows (these are now useless and

incomplete) and initiate the same process again. (Figure B.7)

Figure B.7
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The final result of reinforcement volume fraction that displays the analysis of

particles is shown in Figure B.8.

Figure B.8

2. Differentiate between two or more types of reinforcements
To differentiate two or more reinforcement and find their Volume Fraction the
researcher should use the “Threshold color” plug-in. This process should be done on

images of 200X and 500X. The researcher can follow these steps:

1. Open the Threshold Plug-in (Figure B.9)

Figure B.9
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2. First select the region of interest (ROI) with the freehand line selection ﬂ
tool (Figure B.10)

Figure B.10

3. Select the “sample” button ==/ The Threshold color process will be
completely done It is important take note of the threshold numbers for each process

for future purposes (Figure B.11).

Figure B.11
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4. Then follow the steps of the processing and analyze procedures of 50X

images learned in item 1. The proceeding image shows the result (Figure B.12).

Figure B.12
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APPENDIX C: Quantitative Analysis of Volume Fraction of Pores

To find Volume Fraction of pores the researcher should use the “Threshold
color” plug-in. For this procedure the researcher should use 50X images (Figure
C.1):

Figure C.1

1. Use a ROI to select the black color region of a pore and then from the

Figure C.2
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2. Select in the Threshold color plug-in pop-up menu the “Sample” button sameie |,
(Figure C.3)

Figure C.3

3. At this point the difference respect with reinforcement procedure begins.
Before the traditional processing, do a “smooth” command and then do the
same processing and analysis procedure as if the researcher was looking for
the Volume Fraction of the reinforcements. The “smooth” command is
Process>Smooth (Figure C.4).

Figure C.4
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4. Then follow the steps of the processing and analyze procedures of 50X
images learned in item 1. The proceeding image shows the result (Figure
C.5).

Figure C.5
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APPENDIX D: Quantitative Analysis of Matrix Grain Size

The user should use images at 100X magnification (Figure D.1) and follow

these steps:

Figure D.1

1. With the magnification tool magnify to 100% E

2. With the line tooI]:. make a horizontal line over the Micro-scale in the image

from one border to the other (Figure D.2)

Figure D.2
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3. Go to Analyze>Set Scale... and a pop-up window will appear. Set the known
distance to the distance of the micro-scale and then check the “Global”
Checkbox, essentially setting the scale to all the images after this to the
micro-scale (Figure D.3).

Figure D.3

4. Now select which grain size to study (Figure D.4)

Figure D.4
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5. Horizontally select the edges of the grain boundary (Figure D.5).

Figure D.5

6. Measure the length using the measure command. Go to Analyze> Measure
(Figure D.6).

Figure D.6

Note: A result table will appear. After measuring a sufficient amount of grains, save
the table and name it “Results name of photo”. Then move on to the next
photograph and repeat the procedure. The text file will not be found with the file
extension; so after the researcher puts the file name, add the file extension .txt. This

so that the file can be opened with the notepad or excel software programs.
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APPENDIX E: Quantitative Analysis of Reinforcement Particle Size

The user should use images at 1000x magnification (Figure E.1) and then
should follow these steps:

Figure E.1

1. With the magnification tool magnify to 100% E
2. Use the steps made in Appendix D from 1 through 3

3. Now select which reinforcement particle size to study (Figure E.2)

Figure E.2
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4. Horizontally select (relative to the particle) the edges of the particle boundary
(Figure E.3)

Figure E.3

5. Measure the length using the measure command. Go to Analyze> Measure
(Figure E.4)

Figure E.4
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6. Vertically (relative to the particle) select the edges of the particle boundary
(Figure E.5)

Figure E.5

7. Repeat Step 5.
Note: A result table will appear. After measuring a sufficient amount of

reinforcements save the table and name it “Results name of photo”. Then move on

to the next photograph and do the same procedure.
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